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Chapter 1

Introducing Sage 100 ERP
Chapter 1

Sage, the recognized leader in accounting software for small- and 
mid-size businesses, welcomes you to Sage 100 ERP. The product 
lines offer accounting, distribution, manufacturing, and 
industry-specific applications for virtually every business need. 

About This Guide
The Getting Started Guide is for first-time users and users upgrading 
from previous versions of the software. This guide assumes you have 
a basic understanding of Microsoft Windows®. For more information, 
refer to Help from Microsoft. Before you begin using the software, 
read this guide for a general overview of system features, common 
procedures, and other important information. 

Screens used in this guide reflect the Sage 100 Advanced ERP 
product; similar screens appear in the Sage 100 Standard and 
Premium ERP products. Some sections of this guide reference 
Business Insights Reporter and the eBusiness Manager, Electronic 
Reporting, Fixed Assets, Job Cost, Material Requirements Planning, 
Payroll, TimeCard, and Work Order modules, which are not available 
for Sage 100 Premium ERP.

This guide contains the following information:

• An introduction to the software, including its toolbars, views, 
windows, and navigation tips 

• How to get help while you work

• Hands-on lessons that demonstrate common system-wide 
procedures 

• Troubleshooting information
   Getting Started Guide 1
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Graphic Conventions

The following icons are used throughout this manual to indicate different 
types of information.

The NOTE symbol is followed by additional 
information about a topic.

The WARNING symbol is followed by information 
to help you avoid costly mistakes.

The HELPFUL HINT symbol is located in a grey text 
box and followed by additional information 
about an option.
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Text Conventions

The following table describes the text conventions used in this manual.

Text Convention Explanation

Menus Menus are shown in this format: Select 
menu > menu task name.

Examples: 

• Select File menu > Change 
Company.

• Select General Ledger Budget 
menu > Budget Maintenance.

Bold font Indicates text entered at a field or text 
selected at a field.

Examples: 

• At the Value field, type a search 
value, such as 01, for the lookup.

• In the Filter window, to delete a 
filter, select <none> at a filter's 
Column field.

Italic font Indicates references to other manuals.

Example: 

• For more information about 
installing demo data, refer to your 
Installation and System 
Administrator's Guide.
Getting Started Guide 3
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Where to Find Information
Your Sage 100 ERP system is a powerful, flexible program. The software 
provides several resources to help answer your questions. Sources of 
documentation include the Help system, the Installation and System 
Administrator's Guide, the feature tours, and additional documents. 
Customer Support is available as well.

Help System

Use the Help system when you want overview information, selective 
procedures for day-to-day processing, or detailed information and entry 
samples for a specific field. For more information, see How to Use the Help 
System on page 44.

Installation and System Administrator's Guide

An Installation and System Administrator's Guide is included in your software 
package. This guide provides the information necessary for installing the 
software, detailed system requirements, and troubleshooting tips on the 
configuration of the various operating systems and environments in which 
the software is supported. It is designed to function as a self-teaching guide. 

Customer Upgrade Guide

If you are upgrading from a previous version of the software, the Customer 
Upgrade Guide is also included in your software package and provides 
information on the changes to expect after upgrading to a new version of 
your Sage 100 ERP system. This guide lists changes to the software that 
may affect your daily business processes. For a complete list of 
enhancements, see the What's New page accessible from the Resources 
page of the Sage 100 ERP Desktop. For more information, see What's New 
on page 5.

Feature Tours

Use the feature tours to take a guided tour through the software and learn 
basic features such as entering data and printing reports. Some tours are 
installed with the software and are accessed from the Desktop's Feature 
Tours page. For more information, see Viewing Feature Tours on page 50.
Getting Started Guide 4
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What's New

From the Desktop's Resources page, click What's New to learn about the 
latest software enhancements. Also, on the Resources page, click Getting 
Started to access this guide in an online format. For more information, see 
About the Desktop Web Pages on page 13.

Additional Documents

Additional documents provided for your benefit include Release Notices, 
Supported Platform Matrices, product update information, and file layout 
and program information. 

Use the Release Notices to learn about enhancements, features, and 
modifications for each module of the software release. The Release Notices 
are installed with your software. To view them, access the What's New page 
and click Release Notices.

Refer to the Supported Platform Matrices to learn detailed information 
about operating system compatibility with the software. To access the 
Supported Platform Matrices, go to the Support page on the Sage Customer 
Portal at: https://customers.sagenorthamerica.com

If a product update is available for your version of the software, from the 
Desktop Resources page, click Product Update to view a list of changes 
included in the update.

From the Desktop's Resources page, click the File Layouts and Program 
Information link to view file layout and program information. 

Customer Support

Sage Business Care Support Plans provide you with the technical expertise 
you need to keep your accounting system running smoothly. For more 
information, call 1-866-709-2432 or e-mail us at clientcare.na@sage.com. 
Customer support is also available on the Sage Customer Portal at: 
https://customers.sagenorthamerica.com
Getting Started Guide 5



Chapter 2

Touring the Software
Chapter 2

This chapter is an introduction to the software, its common buttons 
and icons, different views, navigation tips, and common functionality 
available in maintenance and data entry windows. The screens in this 
chapter reflect the ABC company demonstration data, which can be 
installed with your software at any time.

Getting to Know Your Desktop
The Desktop provides access to all installed modules and allows you 
to perform global functions, such as selecting a company, changing a 
module's accounting date, and searching for Help topics. In addition, 
the Desktop Web pages provide you with important information and 
resources. You can customize the Desktop to fit your needs by 
selecting different views, adding buttons to the Custom Buttons 
toolbar, and creating private tasks. Understanding the functions of 
the Desktop allows you to navigate throughout the software.

       NOTE 
Business Insights 
Reporter and the 
Electronic 
Reporting, Fixed 
Assets, Job Cost, 
Material 
Requirements 
Planning, Payroll, 
TimeCard, and 
Work Order 
modules are not 
available for Sage 
100 Premium ERP. 
   Getting Started Guide 6
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Each component of the Desktop is explained on the following pages.

Address Bar Toolbar

Status Bar

On the Tasks tab, select 
a module's menu to 
display the Tree View in 
the Desktop.

Web Navigation 
Toolbar

Custom Buttons ToolbarFind Tasks ToolbarMenu Bar Module Menus Toolbar

Tree View

Desktop Web pageStandard Buttons 
Toolbar

Module Menus Toolbar
Getting Started Guide 7
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• Menu Bar – The menu bar consists of the standard menus that provide 
access to module tasks and other features. You can use either the mouse 
or the keyboard to select the menus. For more information, see Using the 
Keyboard to Access Modules on page 26.

• Toolbars – The six toolbars that appear are the Standard Buttons toolbar, 
Web Navigation toolbar, Module Menus toolbar, Custom Buttons 
toolbar, Find Tasks toolbar, and Address Bar toolbar. For more 
information about each toolbar, see Using Toolbars on page 9.

• Tasks Tabs – The Tasks tabs provide a representation of the menu 
organization.

• My Tasks Tab – The My Tasks tab allows you to add tasks and external 
programs you frequently use into private task folders for quick access. 
For more information, see My Tasks on page 24.

• Desktop Web Pages – The Web pages available are the Information Center 
page, Resources page, Feature Tours page, and Business Insights 
Dashboard page. For more information, see About the Desktop Web 
Pages on page 13.

• Tree View – On the left Tasks tab, select a module to display the Tree 
View. The Tree View provides a visual representation of module menus 
and tasks. For more information, see Tree View on page 23.

• Status Bar – The Status Bar displays the currently selected company 
name and code, active module, user logon, and the active module's 
accounting date. When you select a new task from the Desktop, the 
Status Bar updates to reflect the newly selected module and the 
module's accounting date. If you previously accessed other modules, 
their existing company and accounting date do not change. You can click 
the company, module, user logon, or accounting date area on the Status 
Bar to make changes. For more information, see Learning Common 
Procedures on page 51.

 NOTE 
You can undock the 
Tasks and My 
Tasks tabs from the 
Desktop as a 
stand-alone 
window. For more 
information, see 
Changing the 
Desktop's View on 
page 16.

 NOTE 
You can hide the 
Desktop Web 
pages or Tree View 
by clicking the 
Detail View button 
on the Standard 
Buttons toolbar. For 
more information, 
see Changing the 
Desktop's View on 
page 16.
Getting Started Guide 8
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Using Toolbars

The Desktop displays six toolbars that you can optionally show or hide. To 
toggle toolbars on and off, select View > Toolbars and select the toolbars to 
show or hide. 

All toolbars display by default and are explained in the following pages:

• Module Menus Toolbar on page 10

• Standard Buttons Toolbar on page 11

• Custom Buttons Toolbar on page 12

• Web Navigation Toolbar on page 12

• Find Tasks Toolbar on page 12

• Address Bar Toolbar on page 12

When you resize a toolbar, click the More 
Options button to access the hidden 
toolbar buttons.

Click and drag the grab bar to the left of each toolbar to resize and 
move the toolbars. Also, double-click the grab bar to automatically 
resize the toolbar to its optimal size.
Getting Started Guide 9
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Module Menus Toolbar

The Module Menus toolbar displays module-specific menus for the active 
module. Depending on which module is active, the toolbar updates to 
reflect the current module's menus. 

The following menus are accessible from this toolbar: 

• The Main menu lists the primary functions for a specific module (for 
example, master file maintenance and data entry tasks).

• The Reports menu lists the standard reports available for the module.

• The Period End menu contains the period-end processing tasks 
appropriate for the module.

• The Setup menu contains the module's setup tasks and other 
maintenance tasks necessary to prepare a module for normal processing.

• The Utilities menu contains additional maintenance tasks for the 
module.

• The Custom Reports menu contains default SAP® Crystal Reports® and 
reports added using Report Manager and the Business Insights Reporter 
Wizard.

• For modules with Explore Views available, the Explore menu lists the 
views for the module.

In addition to these standard menus, each module may have one or more 
additional menus unique to that particular module.

 NOTE
When the software 
is first started, the 
module-specific 
menus default to 
the Library Master 
menus.
Getting Started Guide 10
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Standard Buttons Toolbar

The Standard Buttons toolbar consists of buttons used to access common 
tasks. 

• Click the Change Company button to change companies. For 
instructions, see Lesson 1 - Creating a Company on page 52.

• Click the Change Date button to change the accounting date for the 
active module. For instructions, see Lesson 4 - Changing the Accounting 
Date on page 56.

• Click the Change User button to change the user logon. For instructions, 
see Lesson 2 - Creating a User on page 54.

• Click the Master Console button to monitor system activities. For more 
information, see Master Console in the Help system.

• Click the Deferred Print button to view deferred print jobs. For more 
information, see Using Deferred Printing on page 83.

• Click the Business Insights Dashboard button to launch Business 
Insights Dashboard reports. For more information, see Dashboard 
Overview in the Help system.

• Click the Help button to access the Help system. For more information, 
see How to Use the Help System on page 44.

• Click the Detail View button to turn the Desktop's Detail View on or off. 
For more information, see Detail View on page 17.

Change Company

Change Date

Change User

Master Console

Deferred 
Print

Business 
Insights 
Dashboard

Detail View

Launch Sage CRM

Launch Sage  
Fixed Assets Help
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Custom Buttons Toolbar

The Custom Buttons toolbar is just that – customizable. You can drag and 
drop any task from the Tree View onto the Custom Buttons toolbar for 
quick-and-easy access. You can also drag and drop external programs and 
shortcuts (for example, Outlook, Excel, or Calculator) from your desktop 
onto this toolbar to facilitate access to programs you commonly use. In 
addition, you can rename buttons or delete them at any time.

Web Navigation Toolbar

Use the Web Navigation toolbar to navigate through the Web pages in the 
Desktop, similar to navigating in a Web browser such as Internet Explorer.

Find Tasks Toolbar

Use the Find Tasks toolbar to find tasks using keywords. At the Find Task 
field, enter a keyword such as "accounts" and click Find. A list of all tasks 
related to the keyword "accounts" displays in the Desktop.

Address Bar Toolbar

Use the Address Bar Toolbar to browse to any Web site.

 NOTE
The software also 
provides a task to 
customize your 
toolbar instead of 
using the drag and 
drop functionality. 
For instructions, 
see Lesson 7 - 
Customizing the 
Custom Buttons 
Toolbar on page 60.

This task has been added to the Custom 
Buttons toolbar. Click it to display 
Customer Maintenance.

This desktop shortcut has been added to 
the Custom Buttons toolbar. Click it to 
start Microsoft Outlook. 

 NOTE
The Web 
Navigation toolbar 
is not available if 
the Collapsed View 
is displayed. For 
more information, 
see Collapsed View 
on page 18.

Back

Forward

Stop

Refresh

Home
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About the Desktop Web Pages

The Desktop Web pages available are the Information Center page, 
Resources page, Feature Tours page, and Business Insights Dashboard 
page. To display a Web page, select the appropriate page on the Tasks tab.

Information Center Page
From the Information Center page, you can access your MySage page, and find information about Sage training 
and support. There is also a Feedback Site link; click the link to provide your ideas and feedback directly to Sage.
Getting Started Guide 13
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Business Insights 
Dashboard Page
The Business Insights 
Dashboard page provides 
a graphical summary of 
your company’s financial 
data.

Resources Page
From the Resources page, 
you can access the What's 
New page to learn about 
the latest software 
enhancements, view this 
Getting Started Guide, the 
Customer Upgrade Guide, 
and module overview 
documents, access the 
product’s Help system, and 
view file layout and 
program information.
Getting Started Guide 14
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Feature Tours Page
From the Feature Tours page, you can watch videos that demonstrate how to perform various Sage 100 ERP 
tasks such as entering data, using the inquiry features, and creating custom reports. The page also includes 
a series of tours on Business Insights Explorer. 
Getting Started Guide 15
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Changing the Desktop's View

You can change the appearance of the software to fit your needs. The 
Desktop's four basic views are:

• Detail View on page 17

• Collapsed View on page 18

• Minimized View on page 19

• Modules and Tasks View on page 20
Getting Started Guide 16
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Detail View

The Detail View displays the Desktop in its full view. In this view, you have 
the benefit of using the Tasks tab to navigate through the tasks and 
available Web pages, and the My Tasks tab to access public and private task 
folders. 

Use any of the following methods to display the Detail View:

• Select View menu > Detail View.

• On the Standard toolbar, click the Detail View button.

In the Detail View, you can hide the Status Bar by clearing the Status Bar 
selection on the View menu. You can also hide the Tasks and My Tasks tabs 
by selecting View menu > Auto Hide Tasks. To bypass the Information 
Center page the next time you start the software, select View menu > Skip 
Information Center Page. The Tree View appears instead.

 NOTE
When you exit the 
software, if the 
Detail View was the 
last view selected, 
the next time you 
launch the software 
the Detail View will 
display by default.

When the Detail View 
is displayed, the 
Detail View button is 
selected.
Getting Started Guide 17
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Collapsed View

The Collapsed View hides the Tasks and My Tasks tabs, Desktop Web 
pages, Tree View, and Web Navigation toolbar. Use this view if you prefer to 
use the Modules menu to select tasks instead of the Modules tab and Tree 
View. This view is also useful if you want more free space on your desktop. 
If the Status Bar is in view, you can select View menu > Status Bar to hide it.

Use any of the following methods to display the Collapsed View:

• Select View menu > Detail View.

• On the Standard toolbar, click the Detail View button.

NOTE
When you exit the 
software, if the 
Collapsed View was 
the last view 
selected, the next 
time you launch the 
software the 
Collapsed View 
displays by default.

If you click the Business Insights Dashboard 
button in the Collapsed View, the Business 
Insights Dashboard page displays in your default 
Web browser, such as Internet Explorer.
Getting Started Guide 18
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Minimized View

The Minimized View allows you to minimize the Desktop, yet still have 
access to most of the software's functionality. To view the Desktop in its 
minimized state, minimize the Desktop and right-click the software icon in 
the system tray. In the Minimized View, you can change the company, 
accounting date, and user, and access modules and tasks.

 NOTE 
Select View menu > 
Start Minimized to 
set the Minimized 
View as the default 
view when starting 
the software.

software icon
Getting Started Guide 19
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Modules and Tasks View

The Modules and Tasks View allows you to undock the Tasks and My Tasks 
tabs from the Desktop as a stand-alone window. To view the Modules and 
Tasks View, position your pointer over the Tasks and My Tasks panel, and 
click and drag the panel to undock it from the Desktop. You can also 
double-click the Tasks and My Tasks panel title bar to undock the Tasks and 
My Tasks tabs from the Desktop. For more information, see the 
Customizing the Desktop tour available on the Desktop Feature Tours page.

When the Tasks and My Tasks tabs are undocked as a stand-alone window, 
you can move the window anywhere on the screen and resize it. The 
Modules and Tasks View provides access to any module and task on the 
Tasks tab and any task stored on the My Tasks tab without having the full 
Desktop displayed.

       NOTE 
When you exit the 
software, if the 
Modules and Tasks 
View was the last 
view selected, the 
next time you 
launch the software 
the Modules and 
Tasks View will 
display by default.

To re-attach the Tasks and My Tasks 
tabs to the Desktop, double-click this 
title bar. The Desktop must be in Detail 
View.
Getting Started Guide 20
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Accessing Modules and Tasks

The software provides several ways to access modules and tasks. You can 
access modules from the:

• Modules Menu on this page

• Module Menus Toolbar on page 22

• System Tray on page 22

• Tree View on page 23

• My Tasks on page 24

• Find Tasks Toolbar on page 25

• Using the Keyboard to Access Modules on page 26

Modules Menu

The Modules menu allows you to select any of the tasks that are installed 
on your system. You can use your mouse to select tasks from the Modules 
menu, or you can use the keyboard to select the Modules menu by pressing 
ALT+O, and typing the underscored letter of the module and task to access.

The current module is 
indicated by a check 
mark next to the 
module name.

For information on this 
task, see Lesson 5 - 
Changing the Module 
on page 57.
Getting Started Guide 21
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Module Menus Toolbar 

The Module Menus toolbar displays module-specific menus and tasks for 
the active module while the Modules menu is a cascading menu that 
displays menus and tasks for all modules. From any menu, select a task.

System Tray

When the Desktop is minimized, you can right-click the software icon in the 
Windows system tray to access tasks.

The current module 
appears on the 
Status Bar.

       NOTE 
For more 
information about 
the Minimized View, 
see Minimized View 
on page 19. software icon
Getting Started Guide 22
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Tree View

The Tree View provides another alternative for selecting tasks by visually 
representing the menu organization in a tree-like structure in the Desktop. 
On the Tasks tab, select a module to display the Tree View. 

 NOTE
When you use the 
Tree View, the 
active module is not 
changed until you 
select a task in 
another module.

This is the Tree View. The Tree View 
shows the tasks available from the 
menu selected on the Tasks tab. To 
access a task, click it. You can also 
right-click any task to open it in a 
secondary company. For more 
information, see Lesson 8 - Opening a 
Task in a Secondary Company on 
page 63.

You can expand or 
collapse each branch 
of the menu structure 
to show as much, or 
as little, detail as you 
want.

Click a task to access 
it, or right-click a task 
to open it in a 
secondary company.
Getting Started Guide 23
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My Tasks

You can also access tasks by adding them to the My Tasks tab. The My Tasks 
tab is an area where frequently-used tasks, such as inquiry programs, 
desktop shortcuts, and external programs can be added to public or private 
task folders and stored for quick access. Instead of accessing 
commonly-used tasks from the Modules menu or leaving the software to 
start another program such as Microsoft Word, you can add the window or 
program to a task folder and click the task to launch it. 

Public task folders, indicated by the green plus sign, are available to all 
users and are stored on the server. In contrast, private task folders are 
available to individual users and can only be accessed on the workstation 
from which they are created. Private task folders allow individual users to 
customize their own tasks on their workstation.

 NOTE
For instructions on 
how to customize 
My Tasks, see 
Lesson 6 - Creating 
Private Tasks on 
page 58.

You can drag and drop tasks into task 
folders. You can also drag and drop 
shortcuts and programs from your 
desktop into task folders. 

Select the My Tasks 
menu to select a task 
and display the same 
public and private 
task folders that 
appear on the My 
Tasks tab.

The green plus sign 
marks public task 
folders. Click a public 
or private task folder 
to display its contents, 
and click a task to 
open it.
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Find Tasks Toolbar

The Find Tasks toolbar allows you to find tasks using keywords. At the 
Find Task field, enter a keyword such as "invoice" and click the Lookup 
button. A list of all tasks related to the keyword "invoice" appears in the 
Desktop. You can then click a task from the list to access it.

Type a keyword and 
then click the Lookup 
button.
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Using the Keyboard to Access Modules

You can use your mouse to display a menu from the menu bar or Module 
Menus toolbar, or you can use any of the following alternative keyboard 
methods: 

• Use the ALT key plus the underscored letter of the menu: To directly select a 
menu. For example, to select the Main menu, press ALT+M. 

• Use the arrow keys: To select a menu to the right of the one presently 
selected, press the RIGHT ARROW key. Each stroke of the key moves 
the selection one step to the right. To move to the left, press the LEFT 
ARROW key. As a different menu is selected, the menu title is 
highlighted to distinguish it from the other menus. 

When the appropriate menu appears, select the task to access by using the 
following method:

• Use the arrow keys: Use the UP ARROW and DOWN ARROW keys to 
highlight the desired task. When the menu first appears, the first task is 
highlighted. After you highlight a task, you can access that task by 
pressing ENTER.
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Becoming Familiar with Maintenance and Data Entry 
Windows

Throughout the software, maintenance and data entry windows share a 
common set of controls which make learning the software quick and easy. 
Before you begin entering data and performing common tasks, let's look at 
examples of these windows.

Sample Maintenance and Data Entry Window

This sample window shows common data entry features shared by 
maintenance and data entry windows. Some features may not appear in all 
windows.

Click the Lookup 
button to display a 
list of available 
items for a field. For 
more information, 
see Using the 
Lookup Feature on 
page 34.

Selects first, next, last, 
and prior records. 

Click Accept when all information 
is correct and you are finished 
with the current record.

Select a check box to 
respond "yes." Clear 
a check box to 
respond "no." 

Click Cancel to remove 
the information entered.

Click the Help 
button for overviews 
and related 
procedures.

Click Delete 
to delete the 
record.

Click this button to 
view more 
information.

Click the Print 
button to print the 
report associated 
with this window.

Click the Calendar 
button to access the 
Calendar window and 
select a date to return 
to this field.

The window's title bar 
displays the current company 
and accounting date. 

To resize the window, 
click here, hold down 
your left mouse button, 

Select the tabs at the 
top of the window to 
switch tabs of data.

Click the Office 
Merge button to 
access Office 
Template Manager or 
Custom Office.
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Sample Accounts Receivable Line Entry Window

This sample Accounts Receivable Lines tab window shows common grid 
entry features shared by data entry windows in modules other than Job 
Cost, Material Requirements Planning, Payroll, TimeCard, and Work Order. 

In addition to the features illustrated below, you can personalize a data 
entry grid to allow for fast and efficient entry of data. Most columns in a 
grid can be moved, resized, or hidden. You can also freeze a column of data 
so that a particular column remains in view during scrolling. You can resize 
the data entry window, and the Primary and Secondary grids as well. All 
personalizations to grids are saved for your future data entry sessions.

       NOTE 
For more 
information about 
personalizing grids, 
see the Entering 
Data tour available 
on the Desktop 
Feature Tours 
page.

This is the Primary 
grid. It contains the 
main data entry fields.

To locate a specific 
row, type the number 
of the row to view at 
this field. Click the Find 
Row button to use the 
Search Grid window 
for entering criteria to 
find rows that contain 
specific information.

Reset Row 
and Reset 
All Rows

Move Row Up Move Row Down

Insert Row

Delete Row

Click the Calculator 
button to access 
the Calculator 
window and 
calculate a value to 
return to this field. 
Buttons in grids do 
not appear until 
focus is on the field.

This is the Secondary 
grid. It contains 
information for the row 
selected in the Primary 
grid.
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Another feature of data entry windows in modules other than Job Cost, 
Material Requirements Planning, Payroll, TimeCard, and Work Order is the 
right-click menu.

• You can right-click outside of a grid to access system information and 
other tasks. 

• You can also right-click any field in a grid to access additional tasks 
related to the field.

       NOTE 
For more 
information about 
the right-click 
menus, see the 
Feature Tours 
available on the 
Desktop Feature 
Tours page or the 
Help menu.

Right-click outside of a grid to access 
these options. Click System Info to view 
information such as the current user. 
Click Panel Settings to launch the 
Customizer module if it is installed or to 
click Reset Form to reset the form back to 
its default settings. Click Related Tasks to 
select and navigate to a listed task.

Right-click any field 
inside a grid to 
access tasks and 
options related to 
the field. 
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Sample Work Order Line Entry Window

This sample Work Order Entry window shows common line entry features 
shared by data entry windows in the Job Cost, Material Requirements 
Planning, Payroll, and Work Order modules.

Click OK to accept 
the data for a line.

Click Undo to cancel 
changes for a line.

The data entry 
section is used to 
enter and edit data 
for each line.

The list box is used 
to display and select 
entries. 

Click Del to delete 
a line.

Click Ins to insert a 
new line.

The Accept, Cancel, Delete, Print, and 
Browse buttons function the same way, 
regardless of which tab is being viewed.
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Understanding Basic Types of Data

During data entry, you may need to enter the following basic types of data.

Text 

Unformatted entries of alphabetical information (for example, names, 
addresses, and comments) are text entries. 

Dates 

Enter a two-digit month (MM), followed by a two-digit day (DD), 
followed by either a two-digit (YY) or four-digit year (YYYY). Six or 
eight characters can be entered for the date. If a two-digit year is 
entered, the century is determined by the century preferences setting in 
the Windows Control Panel.

You do not need to put a hyphen (-) or slash (/) between the day, month, 
and year; punctuation is inserted automatically. For example, to enter 
May 31, 2010 at a data field, type 053110. (Do not forget the leading zero.) 

Numeric Data 

Empty numeric fields (zero value) display a mask indicating the 
number of digits that can be entered to the right of the decimal point. 
For example, .00 appears if the numeric field accepts two-decimal 
precision. 

Some numeric fields (for example, quantity and hour fields) do not 
assume the decimal point.

To enter negative numbers, type the negative sign (-) as either the first 
or the last character of the entry.

 NOTE 
The M/d/yyyy 
format is the default 
date display format. 
The format of the 
date is set from the 
Windows Control 
Panel.
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Account Numbers 

General ledger account numbers are structured fields consisting of one 
or more segments separated by a hyphen (-) or other separator selected 
at the Account Number Separator field in Account Structure 
Maintenance.

You can enter the value for each segment separated by a hyphen (-). You 
can also zero, or blank fill, each segment to its maximum number of 
characters without using the hyphen (-). 

Example: An account field with a mask of #####-##-###-###-### 
processes your entry in the following manner.

Your Entry...                       Displays As...

1-2-4-6-800                          00001-02-004-006-800
1234567891234567             12345-67-891-234-567
010005                                 01000-05-000-000-000
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Sorting and Selecting Dialog Box Data

You can sort data in columns in ascending or descending order by clicking 
the column heading. Click a column heading to sort the data in reverse 
order. Resize the column headings by clicking and dragging between the 
columns.

Dialog Box Example

You can use the UP ARROW and DOWN ARROW keys to select line items. 
To select more than one line item, press the CTRL key and click the items. 
To select a range of items, press the SHIFT key, click the first item, and then 
click the last item in the range.

Click anywhere within 
the line item to 
select it.

Column headings
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Using the Lookup Feature

When entering data in a maintenance or data entry window, you can click 
the Lookup button at certain fields to display a list of records. You can then 
select the appropriate record. The Lookup feature contains options that 
allow you to filter and customize the search criteria, and create up to 
99 custom lookup views. In addition, you can print the list of records 
appearing in the lookup list box. The illustration below shows a lookup 
window. 

To learn basic features of the Lookup, see Lesson 10 - Using the Lookup's 
Basic Features on page 66. For instructions on how to use advanced features 
of the Lookup, see Lesson 11 - Using the Lookup's Advanced Features on 
page 71.

NOTE
The title of the 
lookup window 
reflects the name of 
the field at which 
you clicked the 
Lookup button.

Click this button to drill 
down to Customer, 
Vendor, or Item Inquiry. 
This button is available 
only in the Customer, 
Item, or Vendor lookup 
window.

After the search is 
complete, the record 
count appears in the 
Status Bar.

Click a column heading 
to sort the list by that 
criteria. An arrow next 
to the heading 
indicates the current 
sort order.

If you click Print while the 
Lookup list box is still loading, 
only the data that has loaded 
prints on the listing.

If filters are already 
defined, the text on this 
button is red.

For some lookups, 
press the F3 and F4 
keys to toggle between 
the key field and the 
Name field.

This field appears only if you 
defined one or more custom 
lookup views. The Standard view 
is generated by the software.

Click this button to 
export data in the lookup 
window to Excel.
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What if you clicked the Lookup button and no records appear in the lookup 
window? This occurs because:

• The number of records is over the limit set at the Lookup Limit for Initial Display field 
in User Maintenance.

• The Initial Display check box on the fifth User Lookup Wizard page is cleared. For more 
information, see User Lookup Wizard in the Help system.

• A custom filter that has no result set is in effect.

To display records, filter the information by using the Search, Operand, and Value fields, 
and then click Find.
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Navigating with Common Buttons, Icons, and Keystrokes

All maintenance and data entry windows share the same set of buttons and 
keystrokes to help you navigate through data and perform common tasks. 
If you prefer to use the keyboard while you work, use the following 
keyboard equivalents.

Button Keystroke(s) Function

Lookup F2 Displays the Lookup window 
for the current field.

Flashlight F3
ALT+L

Displays an alternate lookup 
window for the current field.

Print F4 Prints the report or listing 
associated with the task.

Browse CTRL+F5 Selects the first record.

Browse CTRL+F6 Selects the prior record.

Browse CTRL+F7 Selects the next record.

Browse CTRL+F8 Selects the last record.

Accept ALT+A Saves the current record.

Cancel ALT+C Cancels entry of the current 
record.

Delete ALT+D Deletes the current record.

Print ALT+P Prints the current report.

Preview ALT+V Previews the current report.

Setup ALT+S Displays printer settings.

 NOTE
Pressing the ALT 
key plus the 
underscored letter 
or number functions 
as the hot key for 
any button or tab 
not mentioned here.
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Help SHIFT+F1 Displays Help text for the 
window.

OK ALT+O OK button for dialog boxes and 
line entry.

Undo ALT+U Undo line changes.

Insert Line ALT+N Inserts a line.

Copy From ALT+O Opens the Copy From window.

Delete Line ALT+E Deletes a line.

Batch ALT+B Opens a Batch window where 
you can start a multiple data 
entry session.

E-mail ALT+E Sends e-mail to the address 
entered at the E-mail Address 
field.

Comment 
button

ALT+O Displays extended comments.

Credit Checking ALT+K Displays credit card 
information using the Internet.

Memo ALT+M Opens the Memo Maintenance 
window where you can write a 
memo.

Paperless PDF ALT+F Opens the PDF for the selected 
record.

Button Keystroke(s) Function
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Map ALT+Q Displays Web-based maps for 
locations of customers, 
customer contacts, ship-to 
addresses, vendors, vendor 
contacts, and purchase 
addresses.

Show Image ALT+S Shows the image specified at 
the adjacent field.

Search ALT+S
ALT+X 
(where X is 
unique)

Activates the Search feature for 
records at a field and displays 
the search options for the 
document.

Package 
Tracking

ALT+T Enters a tracking ID number for 
a shipment and accesses a Web 
service to check the status of the 
shipment.

Web ALT+U Launches a Web site based on 
the URL entered at the URL 
Address field.

Next Number ALT+X Selects the next number for the 
field.

Zoom ALT+Z
ALT+X
(where X is 
unique)

Drills down to detail 
information for the item 
selected.

Net Balance ALT+B Calculates the net balance.

Calculator F2 Opens the calculator.

Calendar F2 Opens the calendar.

Button Keystroke(s) Function
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Export to Excel Exports data in the lookup 
window to Excel.

Add Items ALT+I Opens the Add Items to 
Physical Inventory window.

Add New 
Lot/Serial

ALT+L Opens the Add New Lot/Serial 
Number.

Change Budget ALT+B Displays options for changing 
budget amounts.

Unselect All ALT+U Deselects all rows in grid.

Select All ALT+S Selects all rows in a grid.

Total Row Selects the total row in a grid.

Insert Row ALT+N Inserts a row in a grid.

Move Up ALT+U Moves a row up in a grid.

Move Down ALT+W Moves a row down in a grid.

Preview Preview button.

Delete Row ALT+E Deletes a row in a grid.

Reset Row ALT+E Resets a row in a grid.

Save Saves the current entry.

Switch View ALT+S Switches between displaying 
the Net Balance view and the 
Debits and Credits view.

Button Keystroke(s) Function
Getting Started Guide 39



.......................................................................................................................................................................................

BECOMING FAMILIAR WITH MAINTENANCE AND DATA ENTRY WINDOWS

...
...

...
...

.

Folder Lists files in a directory.

MS Office Link
Office Template 
Manager

Accesses MS Office Link or 
Office Template Manager 
templates and attachments 
associated with the option.

Text ALT+I Opens a Text Maintenance 
window where you can write an 
extended description.

TAB Moves to the next field. 

In a grid, pressing the TAB key 
moves focus from cell to cell. At 
the end of the row, pressing the 
TAB key moves to the next row.

ENTER Moves to the next logical field. 

In a grid, pressing the ENTER 
key moves focus from cell to cell 
if the [ENTER] Key like [TAB] 
Key for Grid check box is 
selected in User Maintenance.

SPACEBAR Selects or clears a check box or 
radio button.

BACKSPACE Deletes your entry at a field.

ESC Closes the current window. 

In a grid, pressing the ESC key 
cancels a cell entry.

Button Keystroke(s) Function
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HOME Moves to the first page in a list 
box. 

In a grid, pressing the HOME 
key moves focus to the first cell 
of a row.

END Moves to the last page in a list 
box.

In a grid, pressing the END key 
moves focus to the last cell of a 
row.

PAGE UP Moves to the previous page in a 
list box or grid.

PAGE DOWN Moves to the next page in a list 
box or grid.

CTRL+HOME In a grid, moves focus to the 
first row in the same cell 
position.

CTRL+END In a grid, moves focus to the last 
row in the same cell position.

CTRL+ENTER In a grid, adds line feeds to 
comments.

CTRL+INSERT Inserts a line.

CTRL+DELETE Deletes the current line.

ARROW In a grid, pressing the ARROW 
keys moves focus from cell to 
cell.

Button Keystroke(s) Function
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F1 Displays Help text for the 
current field.

F5 In a grid, toggles between the 
Primary and Secondary grids.

ALT+1, 2, 3... In a data entry window, selects 
the first tab, second tab, third 
tab, and so forth.

Button Keystroke(s) Function
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Getting Help While You Work
Chapter 3

Several sources of information are available to you in the software. 
Use the following resources to find answers to your questions as you 
work.

Feature Tours - A Tour of 
Sage 100 ERP and the 
Business Insights Explorer
Take quick tours through a 
variety of features. These tours 
are available on the Desktop 
Feature Tours page.

Help System - Common Procedures
Quickly find procedures and answers for your 
"how do I" questions by selecting Help menu > Help 
Topics.

Help System - FAQs & Troubleshooting
Find answers to frequently asked questions and 
view troubleshooting information.
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How to Use the Help System
Use the Help system when you want procedures for day-to-day processing, 
detailed information and entry samples for fields, and FAQ and 
troubleshooting information. Overview information and flowcharts 
illustrating complex concepts are also available in Help. If you do not find 
what you need, access information from the additional resources provided 
on the Help menu.

Accessing Help

You can access Help using any of the following methods:

• From the Desktop, select Help > Help Topics. 

• Press F1 at any field in the software to access Help for that field.

• On the Standard Buttons toolbar, click the Help button to access global 
Help topics.

• In the bottom-right corner of any window, click the Help button. Help 
for the specific window appears.

• If you click the Help button and the window has corresponding How Do 
I procedures, a drop-down list of procedures appears. The following 
illustration shows the Help button clicked in the General Journal Entry 
window.

Procedures commonly performed 
in this window appear on this list. 
Click a procedure to view it.

Click here to view overview 
information for the window.
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Using the Help System

After you access the Help system, the following tools help you to locate 
information:

• Using the Contents Tab on page 46

• Using the Index Tab on page 47
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Using the Contents Tab

Use the Contents tab to access the table of contents for the Help system. The 
following illustration explains the common features of the Contents tab. 

When you first 
access Help, the 
Contents tab is 
hidden. Click 
Show to use the 
Contents tab.

The Contents 
tab displays Help 
topics organized 
by key subjects. 
For example, 
clicking Working 
with displays procedures 
organized by subject, such 
as Allocations or Budgets.

The Help system's Home page 
displays links to frequently asked 
questions, information on using the 
Help system, and a list of other 
resources to help you find answers to 
questions about Sage products.
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Using the Index Tab

Use the Index tab to search for specific words or phrases. Each Help topic 
has keywords associated with it. You can search for a topic in the Index by 
entering keywords. The following illustration explains the common 
features of the Index tab.

       NOTE 
When you first 
access the Help 
system, the Index 
tab is hidden. Click 
Show to use the 
Index tab.

Select a topic, and then click Display to view the topic. Or, 
double-click a topic from the list box to view it.

 

Type the first 
few letters of the 
subject for which 
you are 
searching. If the 
topic you are 
searching for is 
not indexed, the 
closest word 
appears in the 
list box. You can 
access index 
entries for all 
modules on the 
Index tab.
Getting Started Guide 47



.......................................................................................................................................................................................

HOW TO USE THE HELP SYSTEM

...
...

...
...

.

Understanding a Help Topic

A Help topic may contain procedural information, overview information, 
or information about a particular feature. 

This section lists items 
that must be 
accomplished before 
performing this 
procedure, or special 
conditions that may 
affect the result of this 
procedure.

At the end of some procedures, 
examples are provided that 
illustrate concepts or tasks 
from the procedure. Click the 
+/- graphic to expand or 
collapse the example.

Click the +/- graphic at this 
link to expand or collapse 
all dynamic drop-down 
links in this topic.

Click FAQs & 
Troubleshooting to 
view frequently asked 
questions grouped in 
common categories, 
such as Budgets or 
Reports.
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About Customer Support
There are several resources you can use for technical assistance before 
contacting your Sage business partner or Customer Support:

• Refer to the software's Help system.

• Refer to the Supported Platform Matrix for information on detailed 
system requirements and troubleshooting tips on the configuration of 
the various operating systems and environments in which the software 
is supported. The Supported Platform Matrix is available on the Support 
page on the Sage Customer Portal at: 
https://customers.sagenorthamerica.com

• If you need access to file layout and program information, click the File 
Layouts and Program Information link on the Desktop's Resources page.

• Attempt to duplicate the issue in one of the sample companies provided 
with your software. This will help a technician identify the problem and 
speed up the process of obtaining a resolution. 

After using the above options, if you require more assistance, select Help 
menu > Customer Support for information on how to contact Sage 
Customer Support.
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Viewing  Feature Tours
On the Desktop Tutorials page, click one of the feature tour links to become 
familiar with basic concepts and features, such as navigating the software, 
customizing your Desktop, and learn how to use Business Insights 
Explorer. These feature tours are a multimedia introduction to the software. 
You can also access additional feature tours on the Web.

To begin, click 
a tour.

Use the Back and Rewind buttons or 
drag the progress marker to navigate 
through the feature tour. Click the 
Rewind button to return to the first 
page of the tour.
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Learning Common Procedures
Chapter 4

Whether you are new to Sage 100 ERP, or an experienced user who 
wants to review basic and advanced concepts, this chapter gives you 
hands-on practice with common procedures.

Lesson Plan
This chapter contains the following lessons:

• Lesson 1 - Creating a Company on page 52

• Lesson 2 - Creating a User on page 54

• Lesson 3 - Changing a User Password on page 55

• Lesson 4 - Changing the Accounting Date on page 56

• Lesson 5 - Changing the Module on page 57 

• Lesson 6 - Creating Private Tasks on page 58

• Lesson 7 - Customizing the Custom Buttons Toolbar on page 60

• Lesson 8 - Opening a Task in a Secondary Company on page 63

• Lesson 9 - Accessing Tasks from Your Desktop on page 65

• Lesson 10 - Using the Lookup's Basic Features on page 66

• Lesson 11 - Using the Lookup's Advanced Features on page 71

• Lesson 12 - Printing Reports, Listings, or Forms on page 78

• Lesson 13 - Defining Formats for Standard Reports on page 92

• Lesson 14 - Customizing Forms on page 98

• Lesson 15 - Creating a Report Setting on page 107

• Lesson 16 - Setting Up Sales Tax Information on page 109

• Lesson 17 - Understanding How Sales Tax is Calculated on 
page 118

• Lesson 18 - Changing Sales Tax Information on page 126

       NOTE 
The Job Cost, 
Material 
Requirements 
Planning, Payroll, 
TimeCard, and 
Work Order 
modules are not 
available for Sage 
100 Premium ERP.
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Lesson 1 - Creating a Company
Many systems are set up with multiple companies to keep financial records 
for individual companies separate, and to separate real company data from 
test company data. Each company is identified by a unique, three-character 
company code. You can process information for a specific company by 
selecting the appropriate company code.

To create a company

1 Select Library Master Main menu > Company Maintenance. 

2 Enter a company code and company name.

3 Enter information in the fields appropriate to your company, including 
the federal ID number.

4 Click Activate to activate one or more modules.
Getting Started Guide 52



.......................................................................................................................................................................................

LESSON 1 - CREATING A COMPANY

...
...

...
...

.

5 When prompted to save the new company, click Yes.

6 When the Activate Module window appears, select the module(s) to 
activate and click Proceed.

7 In Company Maintenance, verify that the modules you selected appear 
in the Activated Modules area of the window and click Accept.
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Lesson 2 - Creating a User
You must enter a valid user logon and type a password, if applicable, before 
you can access the software.

To create a user

1 Select Library Master Main menu > User Maintenance. 

2 Enter the user logon, first and last name, and user code.

If the Use Unified Logon check box is selected in System Configuration, 
the user logon must match the user’s Windows logon key field.

3 Type a password if necessary.

A password is required if the Require all Users to Enter a Password 
check box is selected in System Configuration.

4 On the Maintenance tab, select the company and role to assign to the 
user.

5 On the Preferences tab, select user-specific preferences, and click 
Accept.
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Lesson 3 - Changing a User Password
User passwords can be changed for any user currently logged onto the 
system.

To change a user password

1 Select File menu > Change User Password.

2 In the Old Password field, type the current password for the user. 

3 In the New Password field, type the new password for the user.

4 In the Confirm Password field, type the same password that was typed 
in the New Password field.

5 Click OK.
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Lesson 4 - Changing the Accounting Date
The accounting date is printed on all reports, and represents the date to be 
used while posting transactions for the current module. The Library Master 
accounting date is set from the Windows system date and cannot be 
changed.

To change the accounting date

1 Use any of the following methods to change the accounting date from 
the Desktop:

• Select File menu > Change Date.

• On the Standard Buttons toolbar, click the Change Date button.

• On the Status Bar, click the accounting date area.

2 Type the accounting date.

3 Click OK. The accounting date appears on the Status Bar.

 NOTE 
The M/d/yyyy 
format is the default 
date display format. 
The format of the 
accounting date is 
set from the 
Windows Control 
Panel.
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Lesson 5 - Changing the Module
The active module always displays on the Status Bar. 

To change the module

1 Use either of the following methods to change the module from the 
Desktop:

• Select Modules menu > Switch To.

• On the Status Bar, click the module.

2 Select the module or type the first letter of the module to switch to. 

3 Click OK. The new module displays on the Status Bar and the menus on 
the Modules Menu toolbar change to reflect the new module.

 NOTE
Modules 
automatically 
change when you 
select a task from 
another module 
using the Module 
Menus toolbar, Tree 
View, or Modules 
menu.
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Lesson 6 - Creating Private Tasks
To access tasks quickly, you can organize them into groups of private task 
folders that only you can access on your workstation. You can also add 
external programs (for example, Word, Excel, or SAP Crystal Reports) to 
any private task folder you create.

To create private tasks

1 Right-click in the My Tasks tab area, and select New > Private Folder.

2 Type a name for the new private task folder.

3 Right-click the folder, and select New > Task to add a task.

4 In the Browse window, select the task to add and click Open.
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5 Right-click the folder, and select New > Program to add an external 
program.

6 In the Browse window, locate and select the external program to add 
and click Open.

7 Repeat steps 3-6 to add additional tasks or external programs.

8 Access the private task folder from the My Tasks tab or the My Tasks 
menu.

To create private tasks using the drag and drop method

1 In the Desktop's Tree View, click the task to add to the private task 
folder and hold down your left mouse button.

2 Drag the task from the Tree View to the private task folder on the My 
Tasks tab.

3 When the private task folder is highlighted, release the left mouse 
button to drop the task into the folder.

4 From your computer desktop, click the shortcut (for example, Word, 
Excel, or SAP Crystal Reports) to add to the private task folder and hold 
down your left mouse button.

5 Drag the desktop shortcut to the private task folder on the My Tasks tab.

6 When the private task folder is highlighted, release the left mouse 
button to drop the desktop shortcut into the folder.

Task folder name
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Lesson 7 - Customizing the Custom Buttons Toolbar
The Custom Buttons toolbar can be customized by adding or deleting 
buttons to fit your needs. You can create buttons to access tasks or external 
programs (for example, Word, Excel, or Calculator). There is no limit to the 
number of buttons that can be added to the Custom Buttons toolbar. When 
you resize the toolbar, click the More Options button to access the hidden 
toolbar buttons.

Adding Buttons

To add buttons

1 Use any of the following methods to add a button:

• Select View menu > Toolbars > Customize.

• Right-click any toolbar, and click Customize.

• Right-click the Custom Buttons toolbar, and select Add > Task or 
Add > Program and proceed to step 3 if you are adding a task or step 
4 if you are adding an external program.

2 On the Customize Custom Buttons tab, click New Task to add a button 
for a task.
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3 In the Browse window, locate the task to add and click Open.

4 To add an external program or desktop shortcut, in the Customize 
window, click New Program.

5 In the Browse window, locate the program to add and click Open.

6 To provide more space on your Custom Buttons toolbar, in the 
Customize window, clear the Show Captions check box to hide the text 
labels and display only icons for the buttons you added.

 NOTE 
If you clear the 
Show Captions 
check box, the 
tooltip that appears 
when your cursor 
hovers over the 
button identifies it.
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7 In the Customize window, click OK. The task and external program are 
added to the Custom Buttons toolbar.

Deleting Buttons

To delete buttons from the Custom Buttons toolbar

1 Right-click the button to delete.

2 Click Delete.

Renaming Buttons

To rename buttons on the Custom Buttons toolbar

1 Right-click the button to rename.

2 Click Rename.

3 In the Rename dialog box, type the button's new name and click OK. 

This is an example of a Custom Buttons 
toolbar with text labels and icons.

This is an example of a Custom 
Buttons toolbar with only icons.

When your cursor hovers over a 
button, a tool tip appears to 
identify the button.
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Lesson 8 - Opening a Task in a Secondary Company
From the Desktop, you can open a task in a secondary company without 
changing the current company displayed on the Desktop Status Bar. You 
can define any company as the secondary company.

To open a task in a secondary company

1 In the Desktop's Tree View, right-click a task and select one of the 
following options:

• Open in New Secondary Company: Select this option to define a new 
secondary company and to open the task in that secondary company, 
and then proceed to step 2.

• Open in Secondary Company (ABC): Select this option to open the 
task in the currently defined secondary company. In this example, the 
secondary company defined is ABC, and the task opens in company 
ABC. You are finished.

       NOTE 
To define a new 
secondary company 
without opening a 
task, select Change 
Secondary 
Company from the 
right-click menu.
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2 Select the company to open the task in.

3 Click OK. The task opens in the selected secondary company.
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Lesson 9 - Accessing Tasks from Your Desktop
You can undock the Tasks and My Tasks tabs from the Desktop as a 
stand-alone window, minimize the Desktop, and then use the tabs to access 
the software.

To access tasks

1 In the Desktop's Detail View, double-click the Tasks and My Tasks tabs 
title bar to undock the tabs from the Desktop.

2 Minimize the Desktop by clicking the Minimize button in the 
upper-right corner of the Desktop. The Modules and Tasks window 
remains open on your desktop.

3 To display the Desktop, double-click the Modules and Tasks title bar.

 NOTE 
Select View > Start 
Minimized to start 
the Desktop in the 
Minimized View and 
use the Tasks and 
My Tasks tabs the 
next time you 
access the 
software.
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Lesson 10 - Using the Lookup's Basic Features
When entering data in certain fields in a maintenance or data entry 
window, you can click the Lookup button to display a list of valid records. 
This lesson contains basic procedures on how to use the Lookup feature. To 
learn more advanced features, see Lesson 11 - Using the Lookup's 
Advanced Features on page 71.

Using the Lookup to Select a Record

Use the Lookup feature to display a list of records and select the 
appropriate record.

To select a record using the lookup window 

1 In a window, click a Lookup button. The lookup window appears 
displaying the available records.

2 In the lookup window, select a record from the list box and click Select. 
The record is then selected in the original window. 
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Searching in the Lookup

The lookup window provides a Search field and a Find button to narrow 
your search for desired records. This feature is a convenient way to reduce 
the number of records displayed and helps you to focus on pertinent 
records.

To search in the lookup window

1 In the lookup window, in the Search field, select the field to search.

2 In the Operand field, select an operand. For information about available 
operands, see Filter the Lookup Criteria in the Help system.

3 In the Value field, type a search value for the lookup.

4 Click Find to execute the search. The lookup list box displays the search 
results. In this example, the lookup searches and returns all vendor 
numbers that begin with 01.

5 Select an item from the list box and click Select. The selected record is 
copied to the field.

Operand field Value field

For instructions on this 
button, see Filtering 
the Lookup Criteria 
on page 68.
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Filtering the Lookup Criteria

In any lookup window you can define additional criteria to filter the lookup 
and you can save these filters so that they apply to future lookups until they 
are manually removed. Filtering the lookup criteria helps you narrow your 
search on desired fields.

To filter the lookup criteria

1 In the lookup window, click Filters. In the Filters window, each line item 
is a filter consisting of a Column, Operand, and Value.

2 In the Column field, select the lookup column you want to filter. The 
Column field reflects all of the columns defined for the lookup.

3 In the Operand field, select the appropriate operand. For information 
about available operands, see Filter the Lookup Criteria in the Help 
system.

4 In the Value field, type a value. If you enter multiple values separated 
by commas (,), the system assumes an "OR" condition.

There are two differences between filtering the lookup criteria and searching in 
the lookup. When filtering, you can define an unlimited number of filters on 
multiple lookup fields, and you can save these filters so that they always apply to 

the lookup. In contrast, when you perform a search in the lookup window, you can search 
on only one lookup field, and the search criteria cannot be saved.

 NOTE 
Filters that are 
defined in the User 
Lookup Wizard and 
Lookup 
Customization 
Wizard also appear 
in this window. If the 
filter is locked, it 
cannot be changed. 
If the filter is not 
locked, it can be 
removed or 
modified.
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5 To add additional filters, repeat steps 2 through 4. You can define an 
unlimited number of filters; multiple filters assume an "AND" 
condition.

6 To retain these filters for future lookups, select the Save Filters check 
box.

7 Click OK to apply the filters. In this example, the lookup returns all 
vendors beginning with 01 and ZIP Codes beginning with 7 or 9.

 NOTE 
If the Save Filters 
check box is 
cleared, the filters 
remain in the Filters 
window and remain 
in effect during the 
lookup; however, 
when you exit the 
lookup, these filters 
are removed. 
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Deleting Filters

You can delete filters after they have been defined.

To delete and reset filters

1 In the lookup window, click Filters.

2 To delete a filter, in the Filters window, select <none> in the filter's 
Column field.

3 To delete all filters, click Reset. The filters are cleared, and any filters 
from the custom lookup, if one exists, are restored.

4 Click OK.

 NOTE 
Clicking Reset also 
clears the Save 
Filters check box.
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Lesson 11 - Using the Lookup's Advanced Features
The Lookup has advanced features that allow you to create lookup views, 
create a numeric lookup field, modify a lookup field, and export lookup 
data to Excel. If you are new to the lookup, complete Lesson 10 - Using the 
Lookup's Basic Features on page 66 before starting these procedures.

Creating a Lookup View

For each lookup by company and by user, you can create up to 99 unique 
views. When creating a lookup view, you can define your default view, add, 
remove, or modify fields in the lookup, add or remove filters, as well as 
define several other settings. After creating a lookup view, you can modify 
or delete the view at any time. Keep in mind that any search criteria or 
filters you previously defined will not apply to the new lookup view you 
create.

To create a lookup view

1 In the lookup window, click Custom.

2 On the Lookup Customization Wizard page, in the View field, select 
Create new view and enter a description for the new view. Alternately, 
select an existing view to modify.

3 To set the new lookup view as the default view, select the Default View 
check box. Click Next.

 NOTE 
If another user is in 
the User Lookup 
Wizard and is 
creating or 
modifying a lookup 
code while you 
attempt to create or 
modify a lookup 
view, a message 
appears and 
prevents you both 
from continuing.

 NOTE 
The Custom button 
is not available if 
the Locked 
Customization 
check box is 
selected in the User 
Lookup Wizard.
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4 In the second Lookup Customization Wizard page, add, remove, 
modify, or reorganize the fields for the lookup view in the Selected 
Columns list box. In this example, the TelephoneExt and 
LastPurchaseDate fields have been added to the Selected Columns list 
box, and the ZIP Code field has been moved to the Available Fields list 
box. 

5 Click Next to define additional settings, or click Finish if you have 
completed customizing the view.

6 Use the third Lookup Customization Wizard page to add, delete, or 
modify filters. To continue defining additional settings, click Next; 
otherwise, click Finish.

 NOTE 
The first column 
indicated by an 
asterisk (*) in the 
Selected Columns 
list box cannot be 
removed; however, 
it can be modified. 
For instructions, 
see Modifying a 
Lookup Field on 
page 76.

For more information about 
this button, see Creating a 
Numeric Lookup Field on 
page 75.

For more information about 
this button, see Modifying 
a Lookup Field on 
page 76.

 NOTE 
For a review on how 
to create filters, see 
Filtering the Lookup 
Criteria on page 68.
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7 In the final Lookup Customization Wizard page, make any final 
changes to the lookup view.

• Select the Initial Display check box to load data in the lookup at run 
time. If you do not want data initially loaded in the lookup at run 
time because you have a large number of records and want to 
perform a search before displaying records, clear this check box.

• In the Title field, type a new title that will display in the lookup 
window title bar. 

• In the Default Search Column field, select a default field to appear in 
the Search field in the lookup window.

• In the Default Search Option field, select a default field to appear in 
the Operand field in the lookup window.
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8 Click Finish to see your newly created lookup view. 

The View field appears in the lookup window and the new view, Basic, 
displays the newly added fields. In the example below, the new fields 
are TelephoneExt and LastPurchaseDate, while the deleted ZIP Code 
field no longer appears. Also, the title bar displays Vendor List - Basic 
because this title was defined in the Title field in the last page of the 
wizard and was set as the default view.

The asterisk (*) next to the 
new view indicates that this 
is the default view.

An asterisk (*) appears in 
the title bar to indicate that 
this is a custom view, not 
the Standard view 
generated by the software.
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Creating a Numeric Lookup Field

You can create numeric fields to add to the Selected Columns list box in the 
second Lookup Customization Wizard page. Numeric fields are created by 
combining two or more fields together using arithmetic operators.

To create a numeric lookup field

1 In the second Lookup Customization Wizard page, click New Field to 
create a new numeric field using simple arithmetic functions.

2 In the Lookup Customization Wizard - New Field window, in the 
Heading field, type the name for the column/field.

3 Type the width and select the justification.

4 Type the mask.

5 Click the Calculated Field button to enter simple arithmetic calculations.
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6 In the Calculated Field Builder window, double-click a field in the 
Available Fields list. This moves the field to the expression area. Select 
an operator, choose another field from the list, and click OK.

7 In the Lookup Customization Wizard - New Field window, click OK. 
The newly created field automatically appears as a column in the 
Selected Columns list box.

Modifying a Lookup Field

1 In the second Lookup Customization Wizard page, click Modify to alter 
the selected field in the Selected Columns list box.

2 In the Lookup Customization Wizard - Modify window, make the 
desired changes and click OK. For example, you can change the width 
of the key field to zero if you do not want to display it in the lookup.
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Exporting Lookup Data to Microsoft Excel

You can export the data displayed in a lookup window to Excel. You can 
also select a customized lookup view or perform a search in the lookup 
window to display specific records, and then export the data to Excel.

To export lookup data to Excel

1 In the lookup window, display the data to export to Excel.

2 Click the Excel button. The data in the lookup window is exported to 
Excel.

Excel button
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Lesson 12 - Printing Reports, Listings, or Forms
All reports can be printed, exported or written to a file, and stored for 
deferred printing. You can print a report to a variety of printers or output 
devices. Additionally, reports can be viewed before printing using the 
Preview feature.

Printing a Report, Listing, or Form

To print a listing in modules other than Job Cost, Material Requirements 
Planning, Payroll, TimeCard, or Work Order

1 In the task window that has the Listing feature available (for example, 
General Ledger Options), make the needed selections to the criteria in 
the window and click Print.

2 In the listing window that appears, in the Printer field located in the 
lower-left corner of the window, select the printer.

You can also select alternative printing methods, which are available in 
the Printer field, including:

• Export/E-mail: Reports can be exported to different file types, such 
as PDF or Excel, and saved to your hard drive or e-mailed. For more 
information, see Exporting or Printing to a File on page 87.

• Data Only Export: This option allows only the data portion of the 
report to be exported (header information is excluded). For more 
information, see Exporting or Printing to a File on page 87.

• Deferred: Report printing can be deferred allowing you to save 
reports on your hard drive for printing at a future time. For more 
information, see Using Deferred Printing on page 83.

       NOTE 
Click Preview to 
review the listing 
before printing.
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• Office Merge: If the Custom Office module is installed, you can 
merge your data into a template such as a Microsoft Word or Excel 
template before printing.

3 Click Print to print the listing.

To print a report or form in a module other than Job Cost, Material 
Requirements Planning, Payroll, TimeCard, or Work Order

1 In the report or form window, select either a report setting or a form 
code.

2 You can either accept the default settings for the current report setting 
or form code, or create a new report setting or form code. For more 
information, see Lesson 15 - Creating a Report Setting on page 107. 

       NOTE 
The standard set of 
reports and forms 
are assigned a 
report setting of 
Standard.
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3 In the Printer field located in the lower-left corner of the window, select 
the printer.

You can also select alternative printing methods, which are available in 
the Printer field, including:

• Export/E-mail: Reports can be exported to different file types, such 
as PDF or Excel, and saved to your hard drive or e-mailed. For more 
information, see Exporting or Printing to a File on page 87.

• Data Only Export: This option allows only the data portion of the 
report to be exported (header information is excluded). For more 
information, see Exporting or Printing to a File on page 87.

• Deferred: Report printing can be deferred allowing you to save 
reports on your hard drive for printing at a future time. For more 
information, see Using Deferred Printing on page 83.

• Office Merge: If the Custom Office module is installed, you can 
merge your data into a template such as a Microsoft Word or Excel 
template before printing.

After selecting or modifying the report setting or form code, click Print to 
print the report or form.

       NOTE 
You do not need to 
save the report 
setting or form code 
setting to print the 
report or form.

       NOTE 
Click Preview to 
review the report 
before printing.
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To print a report, listing, or form in the Job Cost, Material Requirements 
Planning, Payroll, TimeCard, and Work Order modules

1 In the report, listing, or form window, the default printer is assigned 
automatically and appears at the bottom of the window.

2 To select a different printer or output device, click Printer Setup.

3 In the Name field, select a printer and click OK.
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4 To preview the report, in the report window, click Preview. 

The Preview feature allows you to view all reports, including 
132-column reports. Use the Browse buttons to page through the report.

5 In the preview window, to copy the current page to the clipboard, click 
the Copy to Clipboard button. Only text is copied; the header, footer, 
underlines, and graphics are not copied.

6 To magnify the report, click the Magnify button. The zoom setting is 
retained when you close the preview window.

7 To search for specific information in the report, click the Search button.

8 Click the Print button. A dialog box similar to the following appears, 
and the report prints.

Magnify button

Search button

Copy to Clipboard button

NOTE
You can also print 
the report by 
clicking Print in the 
report window.
Getting Started Guide 82



.......................................................................................................................................................................................

LESSON 12 - PRINTING REPORTS, LISTINGS, OR FORMS

...
...

...
...

.

Using Deferred Printing

Deferred printing allows you to save reports on your hard drive for 
printing at a future time. You can batch print multiple reports at one time 
without operator intervention between reports. You can also specify the 
number of copies to print for each report, as well as whether to retain the 
deferred report information for future use after printing. In a multi-user 
environment, this feature can postpone the report printing process if 
printers are not currently available, or it can speed up the posting process. 

Deferring a Report

You must first set up reports to be deferred for future printing.

To defer the printing of a report in a module other than Job Cost, Material 
Requirements Planning, Payroll, TimeCard, or Work Order

1 Access the report to defer (for example, the Budget and History Report 
in the General Ledger module) and select the report options.

2 In the Printer field, select Deferred and click Print.
Getting Started Guide 83



.......................................................................................................................................................................................

LESSON 12 - PRINTING REPORTS, LISTINGS, OR FORMS

...
...

...
...

.

3 In the Deferred Print Options dialog box, in the Number of Copies field, 
type the number of copies to print.

4 Select or clear the Purge After Printing check box to either purge or 
retain the report after printing. Select the Secure Report check box to 
restrict other users from printing the report. 

5 Click OK. The report generates to a deferred print file, which can be 
accessed and printed at a later time.

To defer the printing of a report in the Job Cost, Material Requirements 
Planning, Payroll, TimeCard, and Work Order modules

1 Access the report to defer (for example, the Open Work Order Report in 
the Work Order module) and set the report options.

2 Click Printer Setup. 

3 In the Printer Setup dialog box, click the Deferred option.
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4 In the Number of Copies field, enter the number of copies to print and 
click OK. This field can also be modified before printing the deferred 
report.

5 In the Deferred Print Options dialog box, select or clear the Purge After 
Printing check box to either purge or retain the report after printing. 
Select the Secure Report check box to restrict other users from printing 
the report. Click OK.

6 In the report window, click Print. The report generates to a deferred 
print file, which can be accessed and printed at a later time.

Printing Deferred Reports

You can print one page of a deferred report or a range of pages. In addition, 
you can print several copies of a report and more than one report at a time. 
If a report is secured, only the user who initially deferred the report can 
print it.

To print deferred reports

1 To access and print deferred reports from the Desktop, use either of the 
following methods:

• Click the Deferred Print button on the Standard Buttons toolbar.

• Select File > Deferred Printing.

 NOTE 
In the Printer Setup 
dialog box, you can 
also specify all 
report pages to print 
or a page range. 
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2 In the Deferred Printing window, select the report(s) to print. 

• To print all deferred reports, select the Module check box. 

• To print deferred reports for a specific module, select the module's 
check box. For example, select the General Ledger check box to print 
all deferred reports in the General Ledger module.

• To print only selected reports, select each report check box 
individually.

3 To preview a report, select the report and click the Preview Report 
button.

4 To export the report to a different file type (available only for reports in 
modules other than Job Cost, Material Requirements Planning, Payroll, 
TimeCard, and Work Order), click the Export Report button in the 
report preview window.

5 To change printing options for a specific report, select the report and 
click the Show/Modify Report Options button.

       NOTE 
Click the Change 
View button to view 
reports in the 
Deferred Printing 
window sorted by 
module, user, or 
date. Initially, the 
reports are sorted 
by module. 

Change View button
Refresh Report List button

Preview Report button
Show/Modify Report Options 
button

Delete Report button
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6 In the Deferred Report Options window, change the information in the 
Printer, Number of Copies, Collated, Purge After Printing, Secure 
Report, and Page Range fields. Click OK.

7 In the Deferred Printing window, click Print to print the selected reports 
to their assigned printers.

Exporting or Printing to a File

You can send the output of a report to another type of file, such as ASCII, 
delimited, Excel, or dBASE III PLUS. These files can be used by 
spreadsheets, word processing programs, or other applications and include 
the printer driver information. 

Reports in modules other than Job Cost, Material Requirements Planning, 
Payroll, TimeCard, or Work Order can be exported to additional files types, 
such as PDF or HTML, and they can be saved to your hard drive or 
e-mailed. You can also elect to export only the data portion of reports 
(header information is excluded) in these modules.
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To export a report in modules other than Job Cost, Material Requirements 
Planning, Payroll, TimeCard, or Work Order

1 Access the report to export and select the report options.

2 In the Printer field, select one of the following options:

• Export/E-mail: Select this option to export the entire report.

• Data Only Export: Select this option to export only the data portion 
of the report (header information is excluded).

3 Click Print.

4 In the Export dialog box, in the Format field, select the file type for 
exporting. Do not select Lotus 1-2-3 (WK3) or Lotus 1-2-3 (WKS) in the 
Format field; those formats are not supported by Crystal. Instead, use 
the Excel format.

5 In the Destination field, select the location you are exporting to. For 
example, you can export the report to your hard drive or to an 
application such as Excel. Click OK.

To export or print to a file in the Job Cost, Material Requirements 
Planning, Payroll, TimeCard, and Work Order modules

1 Access the report to print to a file and set the report options.

2 Click Printer Setup. 

       NOTE 
To e-mail the report, 
select Microsoft 
Mail (MAPI) in the 
Destination field.
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3 In the Printer Setup dialog box, select the Print to File check box to send 
the output of the report to a different file type.

4 Select the Export File option and click OK.

5 In the Export File Options window, select the file type. The type of 
report selected determines the File Type options available.

6 In the File Name field, accept the default path and file name or modify 
the path and file name.

7 Click OK.

8 In the report window, click Print to print the report to a file.

 NOTE 
All reports can be 
sent to an ASCII 
file, but not all 
reports can be 
printed to other file 
types.

 NOTE 
If you modify the 
default path, the 
subdirectory 
specified must exist 
on the designated 
disk.
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Sending Faxes

To send a fax from the software, a fax driver must be loaded in the 
Windows workstation environment. The fax driver acts as a printer driver 
in the software.

To send a fax in a module other than Job Cost, Material Requirements 
Planning, Payroll, TimeCard, or Work Order

1 Access the report and set the report options.

2 In the Printer field, select the fax driver.

3 Click Preview.

4 In the report preview window, click the Print Report button.

5 In the Print window, click OK.

6 A wizard or window applicable to your fax software appears. Enter the 
necessary information, such as the recipient’s fax number, and send the 
fax.

To send a fax in the Job Cost, Material Requirements Planning, Payroll, 
TimeCard, and Work Order module

1 Access the report and set the report options.

2 Click Printer Setup.

3 In the Printer Setup dialog box, in the Name field, select the fax driver 
and click OK. 

4 In the report window, click Print.

5 A wizard or window applicable to your fax software appears. Enter the 
necessary information, such as the recipient’s fax number, and send the 
fax.
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Paperless Office

You can use the Paperless Office module to fax, e-mail, and store forms in 
PDF format. The Paperless Office module allows you to set up PDF storage 
and electronic delivery options for documents in all Sage 100 ERP 
companies. You can specify separate settings for journals and registers, 
reports, period-end reports, and forms.

This module also contains viewers in which you can view, move, delete, 
and electronically deliver PDFs of customer forms, vendor forms, journals 
and registers, standard reports, and period-end reports.

Purge utilities are also included which allow you to purge PDF documents 
as needed.

You do not need to enable this module in Company Maintenance; however, 
you must enable Paperless Office functionality for each type of document 
you would like to store and electronically deliver. For more information, see 
Set Up Paperless Office in the Help system.

Batch Faxing

Batch faxing allows you to fax multiple forms in batches. During the faxing 
process, forms addressed to the same fax number are collected and sent as a 
group with one cover letter. Batch faxing is set up using Batch Fax Options 
or Fax Form Definition, and requires either the Microsoft Fax Services or 
WinFax 10 fax driver.

The following forms are supported for batch faxing: Statement Printing, 
Accounts Receivable Invoice Printing, Customer RMA Printing, RMA 
Receiver Printing, Sales Order Printing, Picking Sheet Printing, Sales Order 
Invoice Printing, and Purchase Order Printing. For more information, see 
Fax Multiple Forms in Batches in the Help system.
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Lesson 13 - Defining Formats for Standard Reports
You can specify the fonts, style, and data elements to print on the header 
and footer sections of standard reports using Report Format Maintenance. 
You can also define the font and style for the body of the report and add 
bitmaps to the header or background of the standard report. The settings 
that you define establish a report format. 

You can define one report format per company code; a report format is not 
specific to a user logon, workstation ID, or report. The only exception to this 
rule is the ability to override the font in the body of the report in the Printer 
Preferences window; this override is specific to workstation ID.

To define a report format in the Job Cost, Material Requirements 
Planning, Payroll, TimeCard, and Work Order modules

1 Select Library Master Setup menu > Report Format Maintenance. Every 
report is divided into three sections: Header, Body, and Footer. By 
default, the header and footer use the Arial 12 point font and the body 
uses a variable size Times New Roman font.

 NOTE 
This lesson applies 
only to reports in 
the Job Cost, 
Material 
Requirements 
Planning, Payroll, 
TimeCard, and 
Work Order 
modules.

 NOTE 
Dot matrix printers 
are not designed to 
print graphical 
reports and should 
not be used with 
this feature.

Header

Body

Footer
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2 In the Report Format Maintenance window, select Header > Company, 
Report Title, or Subtitles and select settings in each window for the 
header. The following is an example of the Company Information 
window. Access the additional windows from the Report Format 
Maintenance Header menu to select settings for the report header.

3 Select Footer > Sys Date and Page or App Date and User, and select 
settings in each window for the footer. The following is an example of 
the System Date and Page Number window.

 NOTE 
The other windows 
accessed from the 
Report Format 
Maintenance 
Header menu are 
similar in format to 
this window.

 NOTE 
The other window 
accessed from the 
Report Format 
Maintenance Footer 
menu is similar in 
format to this 
window.
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4 Select Body > Font to define font, size and style settings for the body of 
the report.

5 Select Bitmaps > Header or Background to add a bitmap. Bitmaps can 
be printed in the report header area and in the report background area.

6 In the Report Format Maintenance window, click OK to save your 
report settings.

7 Select Library Master Setup menu > Printer Preferences.

Click Auto-Scale to use the automatic scaling 
feature. For more information, see 
Background (Bitmap) in the Help system.
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8 In the Printer Preferences window, select the Enable Graphics Printing 
for this Printer check box to print reports according to the format 
defined in Report Format Maintenance. The Use Graphic Report Format 
check box must also be selected on the User Maintenance Preferences 
tab.

9 In the Printer Preferences window, define the appropriate settings in the 
Normal Font and Compressed Font fields for the report body.

10 Click Accept to print reports for the selected printer in the printer list 
box according to the format defined in Report Format Maintenance.

 NOTE 
The properties 
defined for each 
printer affect only 
standard reports 
and forms. These 
properties do not 
affect reports or 
forms created using 
SAP Crystal 
Reports.

Only printers available 
to the workstation 
appear in this list box.

 NOTE 
The body settings 
you define in the 
Normal Font and 
Compressed Font 
fields override the 
body settings 
defined in Report 
Format 
Maintenance.
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Setting Printing Preferences for Dot-Matrix Printers

To achieve optimum printing speed for dot-matrix printers, native fonts can 
be selected through the Windows driver to increase print speed. 

Some printer drivers may only have the Default selection available for the 
font. If this is the case, you must download an updated driver for your 
printer from the printer manufacturer's Web site or select another 
compatible driver emulation (refer to your printer manual or consult a 
printer manufacturer for details). Each printer has unique font options 
available. Most native font selections will print faster than the Default font 
selection. 

To set printer preferences for dot-matrix printers

1 Select Library Master Setup menu > Printer Preferences.

2 In the Printer Preferences window, select the dot-matrix printer from the 
printer list.

3 Clear the Enable Graphics Printing for this Printer check box. This 
setting is specific to the printer and overrides the global setting.

4 Select the Show Native Printer Fonts Only check box. This is a 
temporary filter and must be selected each time you access this window 
to change a font.

5 In the Normal Font Name field, select 10 CPI Draft, 10 CPI Courier (not 
Courier New), or any font other than Default.

6 In the Normal Font Size field (to match the font selected in the Normal 
Font Name field), select 10.

 NOTE 
When printing 
picking sheets, 
packing lists, Sales 
Order invoices, 
sales orders, 
Accounts Payable 
checks, Accounts 
Payable extended 
stubs, 1099 forms, 
Accounts 
Receivable 
invoices, purchase 
orders, receivers, 
RMAs, or Accounts 
Receivable 
statements, select 
the form code for 
printing to a 
dot-matrix printer. 
For more 
information, see 
Lesson 15 - 
Creating a Report 
Setting on 
page 107.
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7 In the Compressed Font Name field, select a font based on the following 
information.

• If you are using 8.5- x 11-inch paper on a standard-carriage printer, or 
8.5- x 11-inch paper on a wide-carriage printer, select 17 CPI Draft, 
17 CPI Courier (not Courier New), or any font other than Default.

• If you are using 11- x 14-inch paper, select a value between 10 and 15 
(this setting may vary, depending on which printer driver you are 
using).

8 Click Accept.
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Lesson 14 - Customizing Forms
There are two types of forms: graphical and nongraphical. Graphical forms 
use the SAP Crystal Reports writer to print, while nongraphical forms are 
generated directly by the software and are not SAP Crystal Reports-related. 
All form printing tasks allow you to customize the printing of forms and 
save the forms to the Forms file. The Forms file contains a set of default 
formats for printing forms. You can modify the default print formats or 
create new formats. 

Use graphical forms when you want to have optimum control over the font, 
color, and overall presentation quality of the form. You can also customize 
the graphical form by adding bitmaps and company logos to it. These forms 
are designed for you to send to your customers. For an example of a 
graphical form, see page 102.

Use nongraphical forms when you are concerned with the speed of 
printing, rather than the overall presentation quality of the form. 
Nongraphical forms print faster because they do not have bitmaps or 
custom fonts on them. Also, use nongraphical forms if you are printing to a 
dot matrix printer. For an example of a nongraphical form, see page 106.

       NOTE 
This lesson applies 
only to the Job 
Cost, Material 
Requirements 
Planning, Payroll, 
TimeCard, and 
Work Order 
modules.
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Customizing Graphical Forms

You can customize graphical forms, as well as create graphical forms, for all 
form printing tasks using the Forms Customization feature. All graphical 
forms can be printed using a Windows printer; however, you can only 
customize or create forms if the SAP Crystal Reports software is available 
on your workstation. Only managers or experienced Crystal Report users 
should have SAP Crystal Reports installed. 

If a form is modified using the Forms Customization feature, the form will 
be modified for all users and the current company. If you require more 
control of your form customizations, use Library Master Report Manager to 
create forms for a specific user and/or company.

To customize graphical forms in the Job Cost, Material Requirements 
Planning, Payroll, TimeCard, and Work Order modules

1 Access the form printing task to customize.

 NOTE 
This feature is 
available only if the 
applicable graphical 
forms check box is 
selected on the 
Forms tab in the 
module's setup 
Options window.

 NOTE 
If this is the first 
time you are 
selecting the form 
printing task, the 
Form Template 
Selection window 
appears instead of 
the form printing 
task. Select a form 
template.
Getting Started Guide 99



.......................................................................................................................................................................................

LESSON 14 - CUSTOMIZING FORMS

...
...

...
...

.

2 In the Form Code field, click the Lookup button and, in the Form 
Template Selection window, select a form code and click OK. Several 
forms have three default templates: 

• A template for printing on a preprinted form 

• A template for printing on plain paper 

• A template for printing on plain paper in a graphical format with a 
marbled background

The preprinted form prints only data. The graphical form prints data, 
titles, and graphical elements.

3 To print forms to multiple locations, in the form printing task, click 
Multi Part Enable to specify the printers to use for a multi-part form and 
click OK. 

 NOTE 
The Multi-Part 
feature is available 
only if the Multi Part 
Enable check box is 
selected in the form 
printing task 
window.
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For example, using the multi-part feature you can print the following 
copies of a sales order: 

• A file copy to your draft printer 

• A warehouse copy to the printer located in your warehouse 

• An original copy to your high-quality laser printer

4 In the form printing task, click Form to modify a form using the 
SAP Crystal Reports software. The SAP Crystal Reports software 
launches with the form in view.

If you do not have access to the SAP Crystal Reports software on your 
workstation, a dialog box prompts you to install SAP Crystal Reports.

5 In SAP Crystal Reports, make the customizations to the form as needed, 
and save the form.

6 After you have made modifications to your graphical forms using 
SAP Crystal Reports, in the form printing task, click Print. 

7 In the dialog box that appears, click Align to print an alignment pattern 
using the software to verify your new form layout. This is special logic 
built into the software for graphical forms; printing or previewing your 
customized forms from SAP Crystal Reports may not provide an 
accurate presentation of the final form layout. Printing an alignment 
pattern is very important when making modifications to graphical 
forms, such as checks or invoices.
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The following is an example of a graphical marbled form created using 
SAP Crystal Reports.
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Customizing Nongraphical Forms

You can customize the size and alignment of nongraphical forms, as well as 
specify the print position for each data field on form printing tasks. You can 
also customize the heading and titles, and add or delete fields on the form. 
As you customize a nongraphical form, you can save the settings using a 
single-character form code, which allows you to create and save multiple 
formats.

To customize nongraphical forms in the Job Cost, Material Requirements 
Planning, Payroll, TimeCard, and Work Order modules

1 Access the form printing task to customize.

2 In the form printing window, select a form code.

3 To specify the numeric masks and other options for the form, click 
Options.

 NOTE 
To customize 
nongraphical forms, 
the applicable 
graphical forms 
check box must be 
cleared in the 
module's setup 
options window.
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4 In the Form Options window, customize the numeric masks that 
determine how dollar amounts print and other information is used for 
the form, and then click OK.

5 In the form printing window, click Form.

6 On the Forms Customization Header tab, customize the general form 
alignment information to suit your needs.

 NOTE 
The form code 
selected in the form 
printing task 
window appears but 
cannot be changed. 

Click Reset to 
reset the 
information to 
the original 
default values if 
you have made 
changes.
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• Select the Print Descriptions check box to print headers individually 
for each field. If this check box is cleared, all header printing is 
suppressed and cannot be changed.

• Select the Print Compressed check box to print wide forms that 
exceed the standard 80-column format.

• Select the Form Feed check box to force a form feed at the end of each 
form to prevent creeping on subsequent pages. This makes setting 
the length of the form unnecessary.

• In the Length of Form field, set the length to 63 or 64 for Laser and 
Desk Jet Windows printers. If you are printing to a dot matrix printer 
or a Device Configurator Physical device, set the length to 66. An 
incorrect setting may cause the form to creep if the Form Feed check 
box is not selected.

• The Top Margin field setting is used only for forms printed using 
Windows printer drivers. Changing the top margin moves the entire 
form up or down vertically.

7 On the Forms Customization Detail tab, specify the data to print and the 
print positions of each available data field for the form.
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8 Click Accept to save the formats defined.

The following is an example of a nongraphical form.
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Lesson 15 - Creating a Report Setting
After selecting the options and selection criteria for a report, you can save 
these selections for future use by using a unique report setting. You can 
create and save any number of customized report settings per report and 
company. Use this procedure to save a report setting based on an existing 
report setting.

To create a report setting 

1 In the report window, in the Report Setting field, select the setting to use 
as the basis for your new setting.

2 To save the report setting based on another report setting, modify the 
settings in the report window, and then at the Save button click the 
drop-down arrow and select Save As. You can also save the current 
report setting by clicking Save.

       NOTE 
This lesson applies 
only to reports in 
modules other than 
Job Cost, Material 
Requirements 
Planning, Payroll, 
TimeCard, or Work 
Order.
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If Standard is selected in the Report Setting field in the report window, 
you cannot save selections made on the Main or Select tabs in the report 
window to the Standard report setting. The settings made in the report 
window will revert back to the previous Standard report settings. When 
you click Save, the Save As Report Setting window appears allowing 
you to save the changes to another report setting name.

3 In the Save As Report Setting window, in the Description field, type the 
description for the report setting you are saving.

4 In the Type field, select the report type option.

5 To save the report setting as your default report setting, select the 
Default Report check box.

6 To set advanced settings for the report setting, perform the following 
steps:

a Click Advanced. In the Advanced Setting dialog box, select either the 
Standard or Custom option to use a standard or custom report when 
printing the report.

b If you selected the Custom option, enter the path to the custom report 
and click OK.

7 In the Save As Report Setting window, click OK to save the report 
setting. Changes made to an existing report setting are saved to a new 
report setting name or to the current report setting name. The report 
setting that you created will be available in the Report Setting field in 
the report window for future use.

       NOTE 
The standard set of 
reports for modules 
other than Job Cost, 
Material 
Requirements 
Planning, Payroll, 
TimeCard, or Work 
Order are assigned 
a report setting of 
Standard.

       NOTE 
Report and form 
printer information 
is retained by 
workstation and 
form code. When a 
new report setting 
or form code is 
created, the 
workstation ID and 
printer information 
is retained.
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Lesson 16 - Setting Up Sales Tax Information
Depending on the states in which you conduct business and the type of 
business you have, you may be required to calculate sales tax on items sold 
and items purchased. The software allows you to calculate, track, and 
report sales tax information. To calculate sales tax, you must define 
information in Sales Tax Class Maintenance, Sales Tax Code Maintenance, 
and Sales Tax Schedule Maintenance. Sales tax information defined in these 
tasks is available to all companies.

The setup of sales tax information consists of the following four-part 
process:

1 Defining Sales Tax Classes: The tax class is used to define tax 
classifications. These tax classes are then assigned to each sales code, 
inventory item and miscellaneous charge code.

2 Defining Sales Tax Codes: The tax code is used to define whether a tax 
class is taxable. It is also used to define a tax rate, if applicable.

3 Defining Sales Tax Schedules: A tax schedule groups individual tax 
codes.

4 Assigning Sales Tax Schedules: Tax schedules are assigned to each vendor 
and customer based on the vendor's location or purchase address and 
the customer's location or ship-to address.
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Defining a Sales Tax Class

The first step in defining sales tax information is to define different types of 
tax classifications in Sales Tax Class Maintenance. The following three tax 
classes are defined automatically by the system and cannot be deleted: 
Nontaxable (NT), Taxable (TX), and Taxable Freight (TF). A tax class must 
be defined for each classification of goods and services that are taxed at 
different rates.

To define a sales tax class

1 Select Library Master Setup menu > Sales Tax Class Maintenance.

2 Enter a class in the Tax Class field.

3 In the Description field, type a description for the tax class and click 
Accept. Repeat steps 2 and 3 for each tax class you need to define.

After defining sales tax classes, assign the tax classes to sales codes, 
inventory items, and miscellaneous charges.

       NOTE 
The TF (Taxable 
Freight) tax class is 
used to calculate 
sales tax on freight 
amounts.
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Defining a Sales Tax Code

After defining tax classes, you must define sales tax codes in Sales Tax Code 
Maintenance. You must set up a tax code for each tax jurisdiction (such as 
state, county, local or province) to which your business reports sales tax 
information. The defined sales tax codes determine the rate to calculate for 
each tax class defined in Sales Tax Class Maintenance and are used to 
determine if sales tax is calculated on both items sold and purchased.

To define a sales tax code

1 Select Library Master Setup menu > Sales Tax Code Maintenance.

2 Enter a code in the Tax Code field and type a description in the 
Description field.

3 If the tax code you are defining has a limit, type it in the Taxable Limit 
field. For example, some tax jurisdictions have a limit for the amount of 
sales tax that can be defined on an invoice, sales order, or receipt.

4 In the Short Description field, type a short description. This description 
will be used when printing tax detail on forms.
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5 Complete one of the following options:

• Select the Calculate Sales Tax on Retention check box to calculate 
sales tax on the invoice amount less retention. 

• Clear the Calculate Sales Tax on Retention check box to calculate the 
sales tax on the full invoice amount, regardless of retention. For more 
information, see Sales Tax Code Maintenance - Fields in the Help 
system.

6 Complete one of the following options:

• Select the Expense to Vendor/Item check box to allocate the 
non-recoverable portion of purchase's sales tax to the vendor's 
expense account in Accounts Payable or to the inventory account in 
Purchase Order. 

• Clear the Expense to Vendor/Item check box if the non-recoverable 
portion is not to be allocated. For more information, see Sales Tax 
Code Maintenance - Fields in the Help system.

7 Complete one of the following options:

• Select the Tax on Tax check box if this tax code is subject to taxation 
by other tax jurisdictions, and proceed to step 8. 

• Clear the Tax on Tax check box if the tax code is not subject to tax on 
tax, and proceed to step 9. For more information, see Sales Tax Code 
Maintenance - Fields in the Help system.

8 If you selected the Tax on Tax check box, enter a class to be used for 
tax-on-tax calculations in the Tax Class field (next to the Tax on Tax 
check box).

       NOTE 
The Calculate Sales 
Tax on Retention 
check box is 
available only if the 
Job Cost module is 
installed.

       NOTE 
The Tax Class field 
next to the Tax on 
Tax check box is 
the only place you 
can enter a 
tax-on-tax tax class; 
you cannot enter 
this in Sales Tax 
Class Maintenance.
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9 For each tax class defined (except for tax class NT which cannot be 
maintained or deleted), complete the following fields:

a Select the Sales check box to calculate sales tax for this code, or clear 
the Sales check box if sales tax should not be calculated. 

b In the Tax Rate field, type the tax rate percentage to use for 
calculating taxes.

c Select the Purchases check box if purchases are taxable for the tax 
class entered and proceed to step d. Clear the Purchases check box if 
the purchases are not taxable and proceed to step e.

d If the Purchases check box is selected, type the percentage of the 
purchase tax that cannot be recovered in the Non-Recoverable % 
field. Type 0 (zero) at this field if all purchases sales tax is to be posted 
to the Accounts Payable sales account. Type 100 at this field to post all 
of the purchases sales tax to the non-recoverable account.

e Click OK.

10 Click Accept. The following example shows a rate of 7.25 will be 
calculated for items assigned to the Taxable (TX) tax class for items sold.

       NOTE 
If your tax 
jurisdiction charges 
tax on freight, you 
must set up a tax 
rate for the TF tax 
class in each 
applicable tax code. 
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Defining a Sales Tax Schedule

After defining sales tax codes, use Sales Tax Schedule Maintenance to group 
tax codes that make up a total sales tax rate for assignment to customers 
and vendors, and to establish whether tax detail will print on sales orders 
and invoices. For example, if a specific county requires that you calculate 
both state and county tax, create a sales tax schedule that groups the state 
and county tax together.

To define a sales tax schedule

1 Select Library Master Setup menu > Sales Tax Schedule Maintenance.

2 Enter a schedule in the Tax Schedule field and type a description in the 
Description field.
Getting Started Guide 114



.......................................................................................................................................................................................

LESSON 16 - SETTING UP SALES TAX INFORMATION

...
...

...
...

.

3 In the Tax Code field, enter a tax code to add to this tax schedule and 
click OK. Repeat this step for each tax code you want to add to the tax 
schedule.

The sequence in which the tax codes are entered is very important 
because of tax-on-tax calculations and the establishment of the primary 
tax code. If a tax code is taxable by another tax code, it must be 
calculated first. For example, if tax code CA is taxable by tax code OR, 
CA would have to be calculated first to get an accurate calculation for 
the OR tax code. The first tax code entered will become the primary tax 
code. The primary tax code is used during the calculation of taxable and 
nontaxable amounts on each invoice and printing/updating of sales tax 
history. 

4 Click Accept.
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Assigning a Sales Tax Schedule

After sales tax schedules are defined, use Customer Ship-To Address 
Maintenance and Purchase Address Maintenance to assign each customer 
and vendor address to a default tax schedule. Default tax schedules can be 
changed when entering transactions.

To assign a sales tax schedule to a customer address

1 Select Accounts Receivable Main menu > Customer Maintenance.

2 Enter the customer number. Click the drop-down arrow in the top-right 
corner of the window, and then click Ship To Address.

3 In the Customer Ship-To Address Maintenance window, enter the 
Location Code field.

4 In the Tax Schedule field, enter a sales tax schedule and click Accept.
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To assign a sales tax schedule to a vendor address

1 Select Accounts Payable Main menu > Vendor Maintenance.

2 Enter the vendor number.  Click the drop-down arrow in the top-right 
corner of the window, and then click Purchase Address.

3 In the Purchase Address Maintenance window, enter the location code.

4 In the Tax Schedule field, enter a sales tax schedule and click Accept.
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Lesson 17 - Understanding How Sales Tax is Calculated
This lesson provides examples of how sales tax is calculated. These 
examples use the WI (Wisconsin) and WI MIL (Milwaukee) sales tax codes: 

• The WI (Wisconsin state tax) sales tax code is set up to calculate sales tax 
at a rate of 5% on all sales and purchases for items assigned to the 
Taxable tax class. It will not calculate sales tax on other tax classes.

• The WI MIL (Milwaukee city tax) sales tax code is set up to calculate 
sales tax at a rate of 1% percent on all sales for items assigned to the 
Taxable tax class. It will not calculate sales tax on purchases or items 
assigned to other tax classes.

WI (Wisconsin) 
sales tax code

WI MIL 
(Milwaukee) sales 
tax code
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These examples also use the WI (Wisconsin) and WI MIL (Milwaukee) sales 
tax schedules:

• The WI (Wisconsin) sales tax schedule has the WI sales tax code assigned 
to it.

• The WI MIL (Milwaukee) sales tax schedule has both the WI sales tax 
code and the WI MIL sales tax code assigned to it because Milwaukee 
city requires that both state and city tax be calculated for taxable items.

WI (Wisconsin) 
sales tax schedule

WI MIL (Milwaukee) 
sales tax schedule
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Example 1 - How Sales Tax is Calculated in Accounts 
Receivable

This example shows how sales tax is calculated on Accounts Receivable 
invoice 1000158-IN. Invoice 1000158-IN has the following settings:

• On the Invoice Data Entry Header tab, the WI tax schedule is selected.

• On the Invoice Data Entry Lines tab, line item 1 (Standard Gadget) is 
$145 and is assigned to the TX tax class, indicating that this item is 
taxable.

TX tax class is selected 
for the Standard Gadget.

WI (Wisconsin) 
sales tax schedule 
is selected.
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Tax Calculated Using the WI (Wisconsin) Sales Tax Schedule

To view how tax is calculated for invoice 1000158-IN, on the Invoice Data 
Entry Totals tab, click Tax Detail. In the Tax Detail window, you can see that 
$7.25 (100 x 7.25%) in sales tax has been calculated for the WI (Wisconsin) 
sales tax schedule.

WI (Wisconsin) 
sales tax schedule 
is selected.

$7.25 sales tax 
is calculated.
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Tax Calculated Using the WI MIL (Milwaukee) Sales Tax 
Schedule

For invoice 1000158-IN, if the tax schedule on the Invoice Data Entry 
Header tab is changed from WI tax schedule to WI MIL tax schedule, sales 
tax is calculated for both the Wisconsin state (WI) and Milwaukee city (WI 
MIL) sales tax codes because both of theses sales tax codes are included in 
the WI MIL tax schedule.

The following Tax Detail window shows how tax is calculated when the 
WI MIL tax schedule is used. You can see that $7.25 (100 x 7.25%) in sales 
tax is calculated for the (WI) Wisconsin sales tax code, and $1.45 is 
calculated for the (WI MIL) Milwaukee city sales tax code. The total tax 
amount is now $8.70 for the invoice.

WI MIL (Milwaukee) 
sales tax schedule 
is selected.

$8.70 sales tax 
is calculated.
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For invoice 1000158-IN, let's say the same tax schedule of WI MIL is used; 
however, the tax class for the Standard Gadget item on the Invoice Data 
Entry Lines tab has been changed from TX (Taxable) to NT (Non Taxable). 

The following Tax Detail window shows how tax is calculated when the 
NT tax class is assigned to the Standard Gadget item. Notice that sales tax is 
not calculated and the entire invoice displays as a nontaxable sale.

NT tax class is 
selected for the 
Standard Gadget.

No sales tax
is calculated.
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Example 2 - How Sales Tax is Calculated in Accounts 
Payable

This example shows how sales tax is calculated on Accounts Payable 
invoice 75-145. Invoice 75-145 has the following settings:

• On the Invoice Data Entry Header tab, the WI MIL tax schedule is 
selected.

• On the Invoice Data Entry Lines tab, the total distribution amount for 
this invoice is $100.00. This is the total purchase amount that is taxable.

$100.00 is entered 
for the distribution 
amount.

WI MIL (Milwaukee) 
sales tax schedule 
is selected. 
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Tax Calculated Using the WI MIL (Milwaukee) Sales Tax 
Schedule

To view how tax is calculated for invoice 75-145, on the Invoice Data Entry 
Header tab, click Tax Detail. In the Tax Detail window, you can see that 
$5.00 (100 x 5%) in sales tax has been calculated for the WI MIL (Wisconsin) 
sales tax schedule.

Remember that the WI MIL tax schedule calculates tax for both WI 
(Wisconsin state) and WI MIL (Milwaukee city) sales tax codes. Also, keep 
in mind that the WI sales tax code is set up to calculate sales tax on items 
which are purchased (the Purchases check box is selected in Sales Tax Code 
Maintenance), but the WI MIL tax code is not set up to calculate sales tax on 
items which are purchased (the Purchases check box is cleared in Sales Tax 
Code Maintenance). Therefore, sales tax on purchased items is calculated 
only for the WI (Wisconsin) state tax code even though both tax codes (WI 
and WI MIL) are included in the WI MIL tax schedule.

WI MIL (Milwaukee) 
sales tax schedule 
is selected.

$5.00 sales 
tax is 
calculated.
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Lesson 18 - Changing Sales Tax Information
After setting up sales tax information, you may need to modify the sales tax 
information defined in Sales Tax Class Maintenance, Sales Tax Code 
Maintenance, or Sales Tax Schedule Maintenance. For example, the sales tax 
rate for a tax jurisdiction changed.

To change sales tax information

1 Select Library Master Setup menu > Sales Tax Class Maintenance, Sales 
Tax Code Maintenance, or Sales Tax Schedule Maintenance. 

2 The following warning appears informing you that changes you make 
may impact sales tax calculations and reporting. Click OK.

3 Make the necessary changes in Sales Tax Class Maintenance, Sales Tax 
Code Maintenance, or Sales Tax Schedule Maintenance and click 
Accept.

4 You must recalculate the sales tax previously calculated on unposted 
invoices, sales orders, purchase orders, manual checks, returns, and so 
on. To do this, select either Accounts Payable Utilities menu > Sales Tax 
Calculation or Accounts Receivable Utilities menu > Sales Tax 
Calculation.

5 In the Sales Tax Calculation Utility window, select one of the following 
options:

• Select the Recalculate Sales Tax for all Records option to recalculate 
taxes for all records.

       NOTE 
This lesson 
assumes that sales 
tax information has 
been set up and 
sales tax has 
already been 
calculated on 
transactions.

WARNING 
Before recalculating 
sales tax, back up 
all data files.
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• Select the Recalculate Sales Tax for Flagged Records Only option to 
recalculate taxes for only those records that are flagged as invalid tax 
calculation.

6 Click Proceed to recalculate the sales tax.

When sales tax is recalculated, the following occurs:

• Only unposted transactions are affected. This includes sales orders, 
purchase orders, and unposted invoices.

• Posted transactions are not modified. If the amount of sales tax 
calculated was incorrect, you must manually adjust the invoice through 
a credit memo or debit memo.

• Recurring invoices are updated if they contain sales tax information.

       NOTE 
Records that have a 
status of "invalid tax 
calculation" display 
the Recalc Tax 
button in data entry.
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Troubleshooting
Appendix A

What are System Messages?
When the computer system encounters a condition requiring your 
attention, a System Message dialog box appears.

System Message Dialog Box Example

Some messages reflect a normal operational situation, such as the 
printer being off-line. Usually, the resolution is simple, and you can 
proceed without difficulty. 

Other messages can indicate a problem with the hardware or with the 
data files. A problem of this nature may require help from your Sage 
business partner. 
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Obtaining Additional Information

If a message dialog box appears, click Info in the Error window to obtain 
additional information about the message.

Before contacting a Sage business partner, write down any system messages 
appearing on your monitor. Copy the message and indicate the program 
and function being performed when the message occurred. Click the Print 
button to print the error information. 

Click System Info to view 
information regarding the 
workstation. This utility does 
not contain information specific 
to the software.
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Overview of Module Startup
Appendix B

This appendix explains how to successfully upgrade from another 
business management system to Sage 100 ERP for the following 
modules:

• Accounts Payable

• Accounts Receivable

• Bank Reconciliation

• Bar Code

• Bill of Materials

• Common Information Setup Wizard

• eBusiness Manager

• Electronic Reporting for W2 & 1099s

• General Ledger Setup Wizard

• Inventory Management Setup Wizard

• Job Cost

• Material Requirements Planning

• Payroll

• Purchase Order

• Sales Order

• Work Order

This appendix is organized alphabetically for ease of reference. 

 NOTE
The eBusiness 
Manager, Electronic 
Reporting, Job 
Cost, Material 
Requirements 
Planning, Payroll, 
and Work Order 
modules are not 
available for Sage 
100 Premium ERP.
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Accounts Payable 

Accounts Payable Setup Wizard

The Accounts Payable module includes an Accounts Payable Setup Wizard 
that you must perform to convert your existing companies and account 
structure.

The Accounts Payable Setup Wizard provides several pages of questions 
and options that aid you in quickly setting up the Accounts Payable 
module for new companies; you must complete this wizard and the 
Conversion Process on page 132 before using the Accounts Payable 
module.

Data You Need

Before using the Accounts Payable Setup Wizard, have the following 
information assembled and available for use: 

• Your General Ledger Chart of Accounts

• Your bank account number(s) for the checking accounts used by 
Accounts Payable

• A list of standard payment terms offered by your vendors

• A list of your vendors, including address and phone numbers

• A list of all unpaid invoices to be processed

To obtain correct information from your Accounts Payable module, you 
must first bring it up to date with your existing accounts payable system.

 NOTE
Set up your sales 
tax codes, sales tax 
classes, and sales 
tax schedules in 
Library Master 
before using the 
Accounts Payable 
Setup Wizard.
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Conversion Process

Complete the following process to ensure that your system is current. These 
steps should be performed after completing the setup wizard and after 
adding all of your information to the Accounts Payable module.

To convert your existing accounts payable system

1 Identify all unpaid invoices as of your last closed accounting period. 

2 Prepare an adding machine tape totaling the invoices. This amount 
should equal the account balance for Accounts Payable in your general 
ledger. 

3 Set the posting date to the last day of the last closed accounting period. 

4 Using Invoice Data Entry, enter these invoices into the system. Enter the 
outstanding balance amount for each invoice as of the end of the last 
closed accounting period. During the distribution process, post the 
entire distribution balance to your Accounts Payable general ledger 
account. This is done because you have already expensed these invoices 
in a previous accounting period, and to do so again would duplicate 
those expenses. 

By posting to the Accounts Payable account, both a debit and an 
automatic credit are generated in the same amount to the Accounts 
Payable general ledger account; therefore, the two amounts offset each 
other and there is no effect on the general ledger. After the conversion 
process, you would not normally post to the Accounts Payable general 
ledger account, but would post to individual general ledger accounts, as 
appropriate.

As an alternative to this procedure, clear the General Ledger check box 
in Accounts Payable Options. You can then distribute invoices to their 
respective accounts and no general ledger postings are made. If you use 
this alternate procedure, be sure to select the General Ledger check box 
again in Accounts Payable Options after the conversion process has 
completed and you have updated the Daily Transaction Register.
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5 Print the Invoice Register. The total shown on the Invoice Register 
should equal the total on the adding machine tape prepared in step 2. If 
it does not, an error has been made. Check your adding machine tape 
and Invoice Register, return to Invoice Data Entry and make any 
necessary corrections, and then reprint the Invoice Register.

6 Update the invoices.

7 Print the Aged Invoice Report available on the Accounts Payable 
Reports menu, and retain a copy of this report for your accounting files. 
Again, the total on this report should equal the adding machine tape 
total.

8 Run Period End Processing by selecting Period End Processing from the 
Period End menu, and then clicking Proceed. 

9 Reset the posting date to the first day of the current accounting period. 

10 Using Invoice Data Entry, enter any invoices you have received since 
the last closed accounting period. (These invoices should not include 
any invoices entered in step 4.) Post the distribution balance of each 
invoice to its appropriate general ledger account (not to the Accounts 
Payable general ledger account). Print the Invoice Register and update 
the invoices. 

11 Prepare an adding machine tape totaling any checks you have written 
since your last closed accounting period. 

12 Using Manual Check and Payment Entry, enter these checks (step 11) 
into the system. If the check paid an invoice previously entered (step 4 
or 10), no general ledger distribution is required. Type the invoice 
number exactly as you did when you entered it in step 10. If the check 
paid an invoice that you did not previously enter, you must distribute it 
to the appropriate general ledger account(s).

13 Print the Manual Check and Payment Register. The total should equal 
the total of the adding machine tape prepared in step 11. If it does not, 
return to Manual Check and Payment Entry, correct the necessary 
entries, and reprint the Manual Check and Payment Register. When the 
register total and the adding machine tape agree, update the manual 
checks.

WARNING 
If the General 
Ledger check box is 
cleared in Accounts 
Payable Options, 
select the General 
Ledger check box 
before proceeding 
with the update.
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14 Print the Aged Invoice Report and verify that all invoices paid by the 
manual checks recorded in step 12 are listed as paid.

You are ready to begin using your Accounts Payable module.

Accounts Receivable

Accounts Receivable Setup Wizard

The Accounts Receivable module includes an Accounts Receivable Setup 
Wizard that you must perform to convert your existing companies and 
account structure.

The Accounts Receivable Setup Wizard provides several pages of questions 
and options that aid you in quickly setting up the Accounts Receivable 
module for new companies; you must complete this wizard and the 
Conversion Process on page 135 before using the Accounts Receivable 
module.

Data You Need

Before using the Accounts Receivable Setup Wizard, have the following 
information assembled and available for use:

• Your General Ledger Chart of Accounts

• A list of jurisdictions in which you sell and collect sales tax and their tax 
rates

• A list of standard payment terms offered to your customers

• A list of your customers, including addresses and phone numbers

• A list of all invoices to process

• A list of all payments to process

To obtain correct information from your Accounts Receivable module, you 
must first bring it up to date with your existing accounts receivable system.

 NOTE
Set up your sales 
tax codes, sales tax 
classes, and sales 
tax schedules in 
Library Master 
before using the 
Accounts 
Receivable Setup 
Wizard.
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Conversion Process

Complete the following process to ensure that your current accounting 
system is in balance. These steps should be performed after completing the 
setup wizard and after adding all your customers to the Customer file. If 
you maintain Accounts Receivable customers using a balance forward 
method, it is not necessary to enter each invoice. For balance forward 
customers, total all unpaid invoices for each aging category, and enter an 
invoice for each aging category for each customer. 

To convert your existing accounts receivable system 

1 Identify all unpaid invoices as of your last closed accounting period.

2 Prepare an adding machine tape totaling the invoices. This amount 
should equal the account balance for Accounts Receivable in your 
general ledger. 

3 Set the posting date to the last closed accounting period. 

4 Using Invoice Data Entry, enter the invoices using the original invoice 
dates. During the distribution process, post the entire distribution 
balance to your Accounts Receivable general ledger account number. 
These invoices are already posted in an accounting period, and to post 
them again would duplicate the postings. 

By posting to the Accounts Receivable general ledger account, both a 
credit and an automatic debit are generated in the same amount to the 
Accounts Receivable general ledger account. The two amounts offset 
each other and there is no effect on the general ledger. 

After the conversion process, you will not normally post to the 
Accounts Receivable general ledger account, but will post to individual 
general ledger accounts, as appropriate. 
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As an alternative to this procedure, in Accounts Receivable Options, 
clear the General Ledger check box. You can then distribute invoices to 
their respective accounts and no general ledger postings will occur. If 
you use this alternate procedure, be sure to select the General Ledger 
check box again in Accounts Receivable Options after the conversion 
process has completed and you have updated the Daily Transaction 
Register.

5 Print the Sales Journal. The invoice total shown on the Sales Journal 
should equal the total on the adding machine tape prepared in step 2. If 
it does not, an error has been made. Check the adding machine tape and 
the Sales Journal, return to Invoice Data Entry and make any necessary 
corrections, and then reprint the Sales Journal.

6 Update the invoices.

7 Print the Aged Invoice Report and retain a copy of this report for your 
accounting files. The total on this report should equal the adding 
machine tape total.

8 Run Period End Processing by selecting Period End Processing from the 
Period End menu, and then clicking Proceed.

9 Reset the posting date to the first day of the current accounting period.

10 Using Invoice Data Entry, enter any invoices billed since the last closed 
accounting period. (These invoices should not include any invoices 
entered in step 4.) Post the distribution balance of each invoice to its 
appropriate general ledger account (not to the Accounts Receivable 
general ledger account). Print the Sales Journal and update the invoices.

11 Prepare an adding machine tape totaling any cash receipts you received 
since your last closed accounting period.

12 Using Cash Receipts Entry, enter these cash amounts. For the deposit 
amount, enter the adding machine tape total prepared in step 11. If the 
checks entered represent payment for a previously issued invoice (step 
4 or 10), no general ledger distribution is required. If any checks 
represent payment for an invoice not previously issued, you must 
distribute the amounts to the appropriate general ledger accounts.

WARNING
If the General 
Ledger check box is 
cleared in Accounts 
Receivable Options, 
select the General 
Ledger check box 
before proceeding 
with the update.
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13 Print the Cash Receipts Journal. The total should equal the adding 
machine tape total in step 11. If it does not, return to Cash Receipts 
Entry, correct the necessary entries, and reprint the Cash Receipts 
Journal. When the journal total and the adding machine tape agree, 
update the cash receipts.

14 Print the Aged Invoice Report and verify that all invoices that are paid 
by the cash receipts recorded in step 12 are listed as paid. 

You are ready to begin using your Accounts Receivable module.

Bank Reconciliation

Conversion Process

To obtain correct information from your Bank Reconciliation module, you 
must first bring it up to date with your existing bank reconciliation system. 

To convert your existing bank reconciliation system 

1 Verify that all modules being integrated with Bank Reconciliation are 
fully installed and operational. 

2 Select the Bank Reconciliation check box in General Ledger Options, 
Accounts Payable Options, Accounts Receivable Options, Payroll 
Options, and Purchase Order Options, as appropriate. 

3 Manually reconcile the last bank statement for each account that you 
want to use in your bank reconciliation system. 

4 Perform all preliminary startup activities (define the files and set the 
accounting date using the ending date shown on your last reconciled 
bank statement). 

5 Using Bank Code Maintenance, set up the bank code using the ending 
bank balance from your last reconciled bank statement as a source for 
the bank account number and ending bank balance. 
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6 Enter all outstanding checks from your last reconciled bank statement, 
using Check, Deposit and Adjustment Entry. If checks are already being 
processed through the Accounts Payable or Payroll module, these 
outstanding checks should be checks that were updated in the check 
update process, but are not shown on the last bank statement. On the 
Check tab, clear the Cleared check box when these checks are recorded. 

7 Enter all outstanding deposits or adjustments (those not shown on the 
bank statement) in Check, Deposit and Adjustment Entry. If deposits are 
being processed through the Accounts Receivable module, these 
outstanding deposits should have been updated, but not shown, on the 
last bank statement. On the Check tab, clear the Cleared check box when 
these deposits and adjustments are recorded. 

Print the Bank Reconciliation Register to verify the accuracy of the 
information entered. If the information on the register is correct, your Bank 
Reconciliation module is now ready to use. 

Bar Code
Before using the Bar Code module, create and have available the folder 
names that will be used for importing files from the handheld computer. 
Enter this information in Bar Code Setup menu > Bar Code Options.

Bill of Materials

Bill of Materials Setup Wizard

The Bill of Materials module includes a Bill of Materials Setup Wizard that 
you must perform to convert your existing companies and account 
structure.

The Bill of Materials Setup Wizard provides several pages of questions and 
options that aid you in quickly setting up the Bill of Materials module for 
new companies; you must complete this wizard and the Conversion 
Process on page 139 before using the Bill of Materials module.
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Data You Need

Before using the Bill of Materials Setup Wizard, have the following 
information assembled and available for use:

• Your General Ledger Chart of Accounts 

• A single-level bill of materials listing for all bills you want to maintain 

• Any miscellaneous codes that you want to set up, such as for overhead, 
labor, and outside processing

To obtain correct information from your Bill of Materials module, you must 
first bring it up to date with your existing bill-processing system. 

Conversion Process

Complete the following process to ensure that your system is current. These 
steps should be performed after completing the setup wizard. 

To convert your existing bill of materials system 

1 Prepare a list of existing bills from your system. Verify that the 
information is current. 

2 Review the structure of the existing bills. When possible, employ the 
modular bill structure to save work and provide increased flexibility. 

3 Enter the bills in Bill of Materials Maintenance. 

4 Enter the component items, miscellaneous codes, and comments for 
each bill. If your bills use bill options, examine the bills to verify that all 
options and any option interactions are taken into account. 

5 Print a Single-Level Bill of Materials Report for all bills and verify the 
information against the listings provided in your old system. Print an 
Indented Bill of Materials Report and verify that the bill structure is 
correct and complete.
Getting Started Guide 139



.......................................................................................................................................................................................

COMMON INFORMATION

...
...

...
...

.

6 Print a Bill Validation Report. This report examines the entire Bill of 
Materials file. Correct any inaccuracies and print this report again, if 
applicable.

You are ready to begin using your Bill of Materials module.

Common Information

Common Information Setup Wizard

The Common Information module includes a Common Information Setup 
Wizard that you must perform to convert your existing companies and 
account structure.

The Common Information Setup Wizard provides several pages of 
questions and options that aid you in quickly setting up the Common 
Information module for new companies; you must complete this wizard 
before using the Common Information module.

Data You Need

Before using the Common Information Setup Wizard, have the following 
information assembled and available for use:

• A list of miscellaneous items and charges 

• A list of sales tax jurisdictions

• Your bank account number(s) 

eBusiness Manager

eBusiness Manager Setup Wizard

The eBusiness Manager module includes an eBusiness Manager Setup 
Wizard that you must perform to convert your existing companies and 
account structure.
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The eBusiness Manager Setup Wizard provides several pages of questions 
and options that aid you in quickly setting up the eBusiness Manager 
module for new companies; you must complete this wizard before using 
the eBusiness Manager module.

Data You Need

Before using the eBusiness Manager Setup Wizard, have the following 
information assembled and available for use: 

• The IP address and port number for each of the three servers (IIS, SMTP, 
and Web Engine)

• A list of your item categories

• A list of user IDs and passwords to assign to Internet-enabled customers 
(for the .order applet only)

• A list of user ID e-mail addresses and the company to which each user is 
assigned

Electronic Reporting for W2 & 1099s
Before using the Electronic Reporting module, have the following 
information assembled and available for use: 

• The appropriate government forms and publications

• The Quarterly Tax Report printed from the Payroll module 

• A Vendor Listing printed from the Accounts Payable module for which 
you have selected the Print 1099 Payment History check box in the 
Vendor Listing window

General Ledger

General Ledger Setup Wizard

The General Ledger module includes a General Ledger Setup Wizard that 
you must perform to convert your existing companies and account 
structure.

 NOTE
For more 
information 
regarding setup 
procedures, refer to 
your eBusiness 
Manager 
Installation Guide.
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The General Ledger Setup Wizard provides several pages of questions and 
options that aid you in quickly setting up the General Ledger module for 
new companies; you must complete this wizard and the Conversion 
Process on this page before using the General Ledger module to process 
your daily transactions.

Data You Need 

Before using the General Ledger Setup Wizard, you should have the 
following information assembled and available for use:

• Your General Ledger Chart of Accounts

• A Trial Balance from the last completed accounting period 

• Copies of your company's latest financial statements, including the 
Income Statement and Balance Sheet

Conversion Process

To obtain correct information from your General Ledger module, you must 
first bring it up to date with your existing general ledger system. 

• If you are converting at the beginning of a fiscal year, or require only the 
beginning balances for each account, see Enter Beginning Balances in the 
Help system. 

• If you are converting in the middle of a fiscal year and want to record 
activity for each accounting period of the current year, as well as 
beginning balances, see Enter Data for Each Period in the Help system. 

Use these procedures as a checklist to ensure that your current accounting 
system is in balance. These procedures should be performed after 
completing the General Ledger Setup Wizard.
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Inventory Management

Inventory Management Setup Wizard

The Inventory Management module includes an Inventory Management 
Setup Wizard that you must perform to convert your existing companies 
and account structure.

The Inventory Management Setup Wizard provides several pages of 
questions and options that aid you in quickly setting up the Inventory 
Management module for new companies; you must complete this wizard 
and the Conversion Process on page 143 before using the Inventory 
Management module.

Data You Need

Before using the Inventory Management Setup Wizard, have the following 
information assembled and available for use: 

• Your General Ledger Chart of Accounts 

• A list of all inventory items containing costs, prices, on-hand quantities, 
warehouse locations, and reorder requirements

• Any shipping documents, receiving reports, open purchase orders, or 
adjustment vouchers that must still be processed

To obtain correct information from your Inventory Management module, 
you must first bring it up to date with your existing inventory system. 

Conversion Process

Complete the following process to ensure that your current accounting 
system is in balance. These steps should be performed after completing the 
setup wizard and after adding all your inventory items to the Inventory file. 
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To convert your existing inventory system 

1 Prepare a list of current on-hand quantities for all inventory items. You 
can use the balances as of your last closed inventory accounting period 
end, or you can perform a physical count.

2 In Inventory Management Options, in the Current Inventory Period 
field, select the previous period (the last closed period).

3 In Inventory Management Options, clear the General Ledger check box. 

4 Set the posting date to the last day of the last closed accounting period. 

5 In Transaction Entry, enter each item's current on-hand quantity as a 
receipt by selecting Receipts in the Transaction Type field. You must 
enter the quantity on hand and the unit cost for each item. 

You can use a single receipt reference for entering the on-hand 
quantities for all items, or items can be separated into any logical 
grouping and entered under different references. 

6 Print the Transaction Journal and verify all information. If necessary, use 
Transaction Entry to make corrections. 

7 When the register is correct, perform the Transaction Journal update.

8 In Period End Processing, select Full Period End Processing. The current 
period is set to the period in which you begin processing.

9 In Inventory Management Options, select the General Ledger check 
box. 

10 Reset the posting date to the first day of the current accounting period. 

11 Enter any transactions, such as sales, issues, and receipts for the current 
accounting period to bring the inventory management system up to 
date. Use Transaction Entry to record the transactions. 

You are ready to begin using your Inventory Management module.
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Job Cost

Data You Need

Before using the Job Cost module, have the following information 
assembled and available for use:

• Your General Ledger Chart of Accounts

• Determine your accounting and billing methods

• Estimates or estimate worksheets

• Job contracts with all pertinent information

• Estimated price lists

• Standard cost code list

• Job types list 

• Burden rate information 

• Overhead rate information 

• Invoices or billing documents that need to be processed

To obtain correct information from your Job Cost module, you must first 
bring it up to date with your existing job costing system. 

Conversion Process

Complete the following process to ensure your system is current. These 
steps should be performed after completing System Startup and adding all 
jobs, cost codes, and cost types to the Job Cost master file.

To ensure that all accounting modules integrated with Job Cost, including 
the Accounts Payable, Accounts Receivable, Payroll, Purchase Order, and 
Sales Order modules, do not double post transactions that have been 
entered as part of the conversion process, it is recommended that the 
conversion process be performed immediately after the completion of 
period-end processing for all integrated modules.
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To convert from your existing job cost system

1 Prepare a list of job-to-date cost information, detailed by cost code and 
cost type, for each open job. You should use the information from your 
last closed accounting period. If you are changing the coding format of 
your cost codes from your previous system, indicate the new cost codes 
to use for each entry. 

2 In Job Cost Options, clear the Post to G/L for Direct Cost Transactions 
and Post to G/L for Billing & Cash Receipt Transactions check boxes. 
The job-to-date conversion information to be entered should not be 
posted to the general ledger. 

3 Set the Job Cost accounting date to the last day of the last closed 
accounting period. 

4 In Job Posting Entry, enter a separate batch of direct cost entries for each 
job. Enter a separate entry with the job-to-date units (quantity) and 
job-to-date cost for each cost code and/or cost type detail. If each job 
contains a large number of cost code and/or cost type detail, update 
each batch separately. 

5 If the Accounts Receivable module is not integrated with Job Cost, use 
Job Posting Entry to enter billing and cash receipt transactions for each 
job up to the last closed accounting period. Do not enter any billing or 
cash receipts that should be recorded in the current accounting period. 

6 If the Accounts Receivable module is integrated with Job Cost, use Job 
Billing Entry to enter all invoices that have been billed to outstanding 
jobs. Use Accounts Receivable Cash Receipts Entry to enter cash 
receipts for job invoices. If Job Cost is integrated with the General 
Ledger module, you must use General Journal Entry to back out these 
general ledger postings generated for these transactions to prevent 
double posting of information previously recorded. 

Additionally, if invoices relating to job billing are entered in the 
Accounts Receivable module before the installation of Job Cost, reverse 
these invoices using the Adjustment feature in Accounts Receivable 
Invoice Data Entry before recording the job invoices. This prevents 
doubling the invoice information in the Accounts Receivable module. 
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7 If work-in-process accounting is being used, the initial job billing entries 
generate postings to the General Ledger module that adjust the 
appropriate work-in-process accounts with the total accumulated costs 
for each job. You must use General Journal Entry to back out these 
general ledger postings to prevent double posting of information 
previously recorded. 

8 Print the Work in Process Report for all jobs, and check the cost code, 
cost type, and job-to-date information printed. Print the Job Billing 
History Report to check the billing and cash receipt transactions. If any 
errors are found, use Job Posting Entry or Job Billing Data Entry to make 
corrections. 

9 Perform full period-end processing to clear the period-to-date 
information affected by the conversion data. 

10 Reset the accounting date to the first day of the current accounting 
period. 

11 Enter cost and billing transactions for the current accounting period. 
Transactions can be entered directly in the Job Cost module by 
integration with other modules.

12 In Job Cost Options, select the Post to G/L for Direct Cost Transactions 
and Post to G/L for Billing & Cash Receipt Transactions check boxes. 
This allows all future transactions to post to the general ledger.

You are ready to begin using your Job Cost module.

Material Requirements Planning
Before using the Material Requirements Planning module, have a list of 
available warehouses ready for use, and know whether each warehouse is a 
standard distribution/manufacturing warehouse or a distribution 
warehouse that will receive only transferred goods. This information will 
be used to define warehouse groups in Warehouse Group Maintenance.
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Payroll

Data You Need

Before using the Payroll module, have the following information assembled 
and available for use: 

• Your General Ledger Chart of Accounts 

• A list of the earnings and deductions used for payroll processing 

• Employer federal, state, and local tax ID numbers for each tax 
jurisdiction in which your employees are paid 

• Tax tables for the federal, state, and local tax jurisdictions in which your 
employees are paid

• A list of employees, complete with personal information and 
quarter-to-date and year-to-date earnings and deduction history

To obtain correct information from your Payroll module, you must first 
bring it up to date with your existing payroll system. 

In compliance with federal and state tax reporting requirements, payroll 
systems operate on a calendar-year basis. As the year progresses, large 
quantities of quarter-to-date and year-to-date data are accumulated; 
therefore, the ideal time to convert from your existing payroll system to the 
Payroll module is on January 1. If this is not possible for your company, 
guidelines for installing the Payroll module at different times during the 
year follow. 

Converting at the Beginning of the Calendar Year

If you are installing the Payroll module at the beginning of the calendar 
year, enter your information into the module; however, make no entries at 
any quarter-to-date or year-to-date fields. These fields are maintained 
automatically as payroll is processed throughout the year. With these tasks 
completed, you can proceed directly to the year's first payroll cycle. 
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Converting in the Middle of the Calendar Year

To obtain correct year-end totals and proper tax calculations from your 
Payroll module, you must first bring it up to date with your current payroll 
totals, including quarter-to-date and year-to-date earnings and a record of 
vacation, sick leave, and benefit accrued hours.

To record year-to-date information

1 Perform the normal setup procedures, and enter all employee 
information into the system. 

2 In Payroll Options, in the Current Quarter field, select the previous 
quarter. 

3 In Payroll Options, clear the General Ledger check box. This ensures 
that no general ledger postings are made from the Payroll module. 
Because the prior quarter information should already be reflected in 
your general ledger balances, allowing the postings to update would 
result in duplicate postings. 

4 Enter manual checks using Payroll Data Entry for each employee to 
record the year-to-date earnings and tax information. In the Pay Cycle 
window, verify the Manual Taxes check box is selected and the Print 
Checks check box is cleared. You can use the previous quarter number 
as the check number. Enter all earnings, deductions, and tax 
information using the year-to-date information from the end of the 
previous quarter. 

If an employee has worked in more than one state, make sure the 
earnings information is entered separately for each state. 

5 Print the Payroll Data Entry Audit Report and verify all information. If 
necessary, make any corrections using Payroll Data Entry. 

6 Print the Check Register and perform the Check Register update. 
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7 In Period End Processing, select Quarter End Processing. The Current 
Quarter field in Payroll Options increments to the current quarter. 

If you are converting your payroll at the beginning of the current 
quarter, proceed to step 5 in the procedure below. 

If you are converting in the middle of the quarter, you must record each 
check issued during the current quarter using the following procedure.

To record current quarter checks

1 Enter each check issued during the current quarter as a manual check in 
Payroll Data Entry (that is, in the Pay Cycle window, clear the Print 
Checks check box and select the Manual Taxes check box). Enter the 
earnings, deductions, and tax information exactly as written on the 
original checks. You can enter a combined total of the checks issued for 
each employee. This method, however, does not provide the full detail 
and complete audit trail facilitated by a detailed entry of each check. 

2 Print the Payroll Data Entry Audit Report and verify the accuracy of all 
entries. If necessary, make any corrections using Payroll Data Entry and 
reprint the Payroll Data Entry Audit Report. 

3 Print the Check Register and perform the Check Register update. 

4 Print the Daily Transaction Register and perform the Daily Transaction 
Register update. 

5 Print the Quarterly Tax Report and the Payroll Check History Report, 
and verify all employee information. 

6 Print and verify the Benefits Register. If adjustments are necessary, 
access individual employee records in Employee Maintenance. 

7 In Payroll Options, select the General Ledger check box. This allows all 
future payroll processing to post to the general ledger. 

You are ready to begin using the Payroll module.
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Purchase Order

Purchase Order Setup Wizard

The Purchase Order module includes a Purchase Order Setup Wizard that 
you must perform to convert your existing companies and account 
structure.

The Purchase Order Setup Wizard provides several pages of questions and 
options that aid you in quickly setting up the Purchase Order module for 
new companies; you must complete this wizard and the Conversion 
Process on page 152 before using the Purchase Order module.

Data You Need

• Before using the Purchase Order Setup Wizard, have the following 
information available for use:

• Your General Ledger Chart of Accounts 

• A list of vendor quantity discount rates you use for inventory items

• A list of all addresses to which you have orders shipped

• All open purchase orders and back orders

• All receipts, invoices, returns, and material requisitions as of your last 
closed accounting period

To obtain correct information from your Purchase Order module, you must 
first bring it up to date with your existing purchase order system. 
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Conversion Process

Complete the following process to ensure that your current accounting 
system is in balance. These steps should be performed after completing the 
setup wizard. 

To convert your existing purchase order system 

1 Gather all open purchase orders as of your last closed accounting 
period. 

2 Prepare an adding machine tape totaling the orders. 

3 Use Purchase Order Entry to enter the orders into the system. In Default 
Values for Purchase Order Entry, clear the Print Purchase Orders check 
box to prevent the conversion orders from being reprinted. Next, on the 
Purchase Order Entry Header tab, select Standard Order in the Order 
Type field and Open in the Order Status field for each order. 

Partially received or invoiced purchase orders cannot be processed 
using the system without double posting to the General Ledger and 
Inventory Management modules. These orders should be processed 
manually until they are completed. To enter these orders, you must 
enter only the unreceived balance on each order as the original order 
quantity. There are no such restrictions for outstanding orders that have 
not received any partial receipts or invoices against them. 

4 Print the detail version of the Open Purchase Order Report for all order 
types and orders with an open status. The total on this report should 
equal the total on the adding machine tape you prepared in step 2. If the 
totals do not agree, return to Purchase Order Entry and make any 
necessary corrections and reprint the report as an audit record of your 
outstanding orders. 

5 Record all receipts, invoices, returns, and material requisitions that you 
have received since the last closed accounting period to bring the 
system completely up to date. 

You are ready to begin using your Purchase Order module.
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Sales Order

Sales Order Setup Wizard

The Sales Order module includes a Sales Order Setup Wizard that you must 
perform to convert your existing companies and account structure.

The Sales Order Setup Wizard provides several pages of questions and 
options that aid you in quickly setting up the Sales Order module for new 
companies. You must complete this wizard and the Conversion Process on 
page 154 before using the Sales Order module to process your daily 
transactions.

Data You Need

Before using the Sales Order Setup Wizard, have the following information 
assembled and available for use: 

• Your General Ledger Chart of Accounts

• A list of standard miscellaneous charges and items used in your 
business

• A list of item part numbers sold by your business (if the Inventory 
Management module is not integrated with Sales Order)

• A list of your shipping rates

• All open orders and back orders

• A Customer Listing from your Accounts Receivable module

• An Inventory Item Listing from your Inventory Management module

To obtain correct information from your Sales Order module, you must first 
bring it up to date with your existing order processing system. 
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Conversion Process 

Complete the following process to ensure that your current accounting 
system is in balance. These steps should be performed after completing the 
setup wizard. First, enter any unpaid invoices, as of your last closed 
accounting period, into the Open Invoice file. This process is performed 
using the Accounts Receivable module. Second, use the Sales Order module 
to enter any open orders or back orders into the system. 

To convert your existing sales order system 

1 Identify all open orders as of your last closed accounting period. 

2 Prepare an adding machine tape totaling the orders. 

3 Using Sales Order Entry, enter these orders into the system. Use the 
standard order type for standard sales orders, and the open order status 
for open orders. When entering the Sales Order Entry default values, 
clear the Print Sales Orders and Print Pick Sheets check boxes, and enter 
00 in the No. of Ship Labels field in the Default Values for Sales Order 
Entry dialog box to prevent these documents from being printed. 

4 Identify all open back orders as of your last closed accounting period. 

5 Prepare an adding machine tape totaling the back orders. 

6 Using Sales Order Entry, enter these back orders into the system. Use 
the back-order order type for back orders, and the open order status for 
open orders. 

7 Print the detail version of the Open Sales Order Report for all order 
types and the open order status. The Open Order and Open Back Order 
totals shown on this report should equal the totals on the adding 
machine tapes prepared in steps 2 and 5. If the totals do not agree, check 
your adding machine tapes and the Open Sales Order Report. Return to 
Sales Order Entry and make any necessary corrections, and then reprint 
the report as an audit record of your outstanding orders. 

You are ready to begin using the Sales Order module.
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Work Order

Data You Need

Before using the Work Order module, have the following information 
assembled and available for use:

• Your General Ledger Chart of Accounts

• A list of work center locations, including the number of employees and 
number of standard hours available per week at each location

• A list of operations to be performed, including cost and overhead 
calculations and general ledger production cost accounts

• A list of employees (optional), including labor rates and social security 
numbers

• A list of labor crews (optional), including the employees in each crew

• A calendar of days when the entire shop is closed

• A calendar for each work center with exceptions to the shop calendar

• A list of tools to be used during operations (optional)

To obtain correct information from your Work Order module, you must first 
bring it up to date with your existing work order system. 

Because the Inventory Management module is integrated with Work Order, 
it may be impractical to bring the system up to date and reconstruct the 
original material cost information that should have been recorded. If you 
have installed the Inventory Management module, it is difficult to record 
past material issue transactions for work orders without affecting the 
current inventory balances. 
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The easiest and most effective way to convert the Work Order module is to 
enter only new work orders into the system. Do not record any transactions 
related to preexisting work orders using the Work Order module. You can 
use the Inventory Management module or the Bill of Materials module to 
record issues and receipts related to these work orders. For labor and 
miscellaneous expenses, the general ledger can be adjusted directly using 
General Ledger General Journal Entry. If the duration of your work orders 
is short, you can quickly complete the conversion process after all of the 
preexisting work orders are completed. 

Conversion Process

Complete the following process to ensure that your current accounting 
system is in balance. 

To convert your existing work order system

1 In Work Order Options, clear the General Ledger check box to prevent 
any postings being made to the general ledger while entering 
conversion information.

2 Enter all open work orders using Work Order Entry. 

3 Enter all transactions recorded for open work orders using Work Order 
Transaction Entry. Material costs may not be the same as the original 
costs. 

4 Print the Work Order Transaction Journal, and perform the update. 

5 Print the Open Work Order Report to verify the information recorded. If 
adjustments are necessary, repeat steps 3 and 4. 

6 Print the Work in Process Recap report to verify the information 
recorded and to reconcile to the general ledger.
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7 If you are entering material transactions for existing work orders, you 
can freeze inventory and perform a physical count and physical count 
entry without updating. Updating the Physical Count Variance Register 
should be performed only after all material issue transactions are 
recorded for existing work orders. Adjustments made during the 
Physical Count Variance Register update are recorded as physical 
adjustments in the Inventory Management Detail Transaction file. The 
Inventory Adjustment account in each item's product line is used to 
offset the Inventory account posting, unless the General Ledger check 
box is cleared in Inventory Management Options during the update 
process.

8 Perform the physical inventory process to update the quantity-on-hand 
information in inventory. This step should be performed after all 
material issue transactions have been recorded for open work orders. 

You are ready to begin using your Work Order module. 
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Help system 44
methods 43
Read Me files 5
Supported Platform Matrices 5

how to use Help system 44

I
icons and buttons 36
Index tab, Help 47
Information Center 13
Installation and System Administrator’s 

Guide 4
Inventory Management

conversion process 143
data you need 143
setup wizard 143

J
Job Cost

conversion process 145
data you need 145

K
keyboard shortcuts

accessing modules using 26
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keyboard shortcuts (continued)
entering data with 36
navigating with 36

keystrokes, navigating with 36

L
learning, common procedures 52
lessons

accessing My Tasks from desktop 65
changing

accounting date 56
company 52
module 57
user 54
user password 55

creating
private tasks 58
report setting 107

customizing
Custom toolbar 60
forms 98
graphical forms 99
nongraphical forms 103

defining formats for standard 
reports 92

opening tasks in secondary company 63
overview 52
printing forms and reports 78
setting up sales tax information 109
using

Lookup’s advanced features 71
Lookup’s basic features 66

listing, printing 78
lookup

creating
field 75
view 71

deleting filters 70
exporting data to Excel 77
filtering 68
modifying lookup field 76
overview 34
searching in 67
selecting a record 66
using

advanced features 71
basic features 66

window sample 34
Lookup feature, See lookup

M
Material Requirements Planning, data you 

need 147
menu bar 8
messages, system 128
Minimized View, Desktop 19
modifying lookup field 76
Module Menus toolbar

overview 10
sample 10

modules
accessing 21
changing 57

Modules and Tasks View, Desktop 20
Modules menu 21
My Tasks

accessing from desktop 65
drag and drop private tasks 59
menu 24
overview 24
private tasks, creating 58
window sample 24

N
navigating with buttons and keystrokes 36
new features 5
nongraphical forms

customizing 103
sample 106

P
Paperless Office 91
password, changing 55
Payroll

converting beginning of calendar 
year 148

converting middle of calendar year 149
data you need 148

printers, Dot-Matrix 96
printing

deferred 83
file types 87
forms 78
listings 78
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printing (continued)
reports 78
sending faxes 90
setting preferences for Dot-Matrix 

printers 96
private tasks, creating 59
procedures, learning common 52
Purchase Order

conversion process 152
data you need 151
setup wizard 151

Q
questions, See getting help

R
Read Me files 5
renaming buttons 62
report setting, creating 107
reports

creating report setting 107
defer printing 83
defining formats 92
e-mailing 87, 91
exporting 87
faxing 91
printing 78
printing deferred 85
printing to file 87
sending faxes 90
storing as PDFs 91

Resources page 14

S
Sales Order

conversion process 154
data you need 153
setup wizard 153

sales tax, See tax
searching in lookup 67
secondary company, opening task in 63
selecting record using lookup 66
sending faxes 90
Standard toolbar

overview 11
sample 11
Status Bar 8
support, customer 49
Supported Platform Matrices 5
system messages

error information 129
window sample 128

System Startup, converting to a Sage 100 ERP 
system 130

system tray sample 22

T
tasks

drag and drop private 59
opening in a secondary company 63
overview 24
private, creating 58

Tasks tab 8
tax

class, defining 110
code, defining 111
examples 118

Accounts Payable 124
Accounts Receivable 120

overview 109
sales

changing 126
setting up 109

schedule
assigning 116
defining 114

toolbars 9
Address Bar 12
buttons

adding 60
deleting 62
renaming 62

Custom 12
customizing 60
Find Tasks 12
Module Menus 10
overview 9
Standard 11
Web Navigation 12

Tree View 23
troubleshooting

obtaining additional information 129
system messages 128
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U
user logon, changing 54
user password, changing 55

V
views, Desktop

Collapsed 18
Detail 17
Minimized 19
Modules and Tasks 20

W
Web Navigation toolbar

overview 12
sample 12

Web page samples
Business Insights Dashboard 14
Desktop 13
Feature Tours 15
Information Center 13
Resources 14

web page samples
Feature Tours 13

What’s New page 14
when to use help 44
window samples

data entry 27
Desktop 7
dialog box 33
feature tours 50
Help topic 48
line entry 28, 30
lookup 34
My Tasks 24
system message 128
system tray 22
Tree View 23

Work Order
conversion process 156
data you need 155
Getting Started Guide 163


	Introducing Sage 100 ERP
	About This Guide
	Graphic Conventions
	Text Conventions

	Where to Find Information
	Help System
	Installation and System Administrator's Guide
	Customer Upgrade Guide
	Feature Tours
	What's New
	Additional Documents
	Customer Support


	Touring the Software
	Getting to Know Your Desktop
	Using Toolbars
	About the Desktop Web Pages
	Changing the Desktop's View
	Accessing Modules and Tasks

	Becoming Familiar with Maintenance and Data Entry Windows
	Sample Maintenance and Data Entry Window
	Understanding Basic Types of Data
	Sorting and Selecting Dialog Box Data
	Using the Lookup Feature
	Navigating with Common Buttons, Icons, and Keystrokes


	Getting Help While You Work
	How to Use the Help System
	Accessing Help
	Using the Help System
	Understanding a Help Topic

	About Customer Support
	Viewing Feature Tours

	Learning Common Procedures
	Lesson Plan
	Lesson 1 - Creating a Company
	Lesson 2 - Creating a User
	Lesson 3 - Changing a User Password
	Lesson 4 - Changing the Accounting Date
	Lesson 5 - Changing the Module
	Lesson 6 - Creating Private Tasks
	Lesson 7 - Customizing the Custom Buttons Toolbar
	Adding Buttons
	Deleting Buttons
	Renaming Buttons

	Lesson 8 - Opening a Task in a Secondary Company
	Lesson 9 - Accessing Tasks from Your Desktop
	Lesson 10 - Using the Lookup's Basic Features
	Using the Lookup to Select a Record
	Searching in the Lookup
	Filtering the Lookup Criteria

	Lesson 11 - Using the Lookup's Advanced Features
	Creating a Lookup View
	Exporting Lookup Data to Microsoft Excel

	Lesson 12 - Printing Reports, Listings, or Forms
	Printing a Report, Listing, or Form
	Using Deferred Printing
	Exporting or Printing to a File
	Sending Faxes
	Paperless Office
	Batch Faxing

	Lesson 13 - Defining Formats for Standard Reports
	Setting Printing Preferences for Dot-Matrix Printers

	Lesson 14 - Customizing Forms
	Customizing Graphical Forms
	Customizing Nongraphical Forms

	Lesson 15 - Creating a Report Setting
	Lesson 16 - Setting Up Sales Tax Information
	Defining a Sales Tax Class
	Defining a Sales Tax Code
	Defining a Sales Tax Schedule
	Assigning a Sales Tax Schedule

	Lesson 17 - Understanding How Sales Tax is Calculated
	Example 1 - How Sales Tax is Calculated in Accounts Receivable
	Example 2 - How Sales Tax is Calculated in Accounts Payable

	Lesson 18 - Changing Sales Tax Information

	Troubleshooting
	What are System Messages?
	Obtaining Additional Information


	Overview of Module Startup
	Accounts Payable
	Accounts Payable Setup Wizard
	Data You Need
	Conversion Process

	Accounts Receivable
	Accounts Receivable Setup Wizard
	Data You Need
	Conversion Process

	Bank Reconciliation
	Conversion Process

	Bar Code
	Bill of Materials
	Bill of Materials Setup Wizard
	Data You Need
	Conversion Process

	Common Information
	Common Information Setup Wizard
	Data You Need

	eBusiness Manager
	eBusiness Manager Setup Wizard
	Data You Need

	Electronic Reporting for W2 & 1099s
	General Ledger
	General Ledger Setup Wizard
	Data You Need
	Conversion Process

	Inventory Management
	Inventory Management Setup Wizard
	Data You Need
	Conversion Process

	Job Cost
	Data You Need
	Conversion Process

	Material Requirements Planning
	Payroll
	Data You Need
	Converting at the Beginning of the Calendar Year
	Converting in the Middle of the Calendar Year

	Purchase Order
	Purchase Order Setup Wizard
	Data You Need
	Conversion Process

	Sales Order
	Sales Order Setup Wizard
	Data You Need
	Conversion Process

	Work Order
	Data You Need
	Conversion Process





